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About vFabric Hyperic Monitoring and Management 
vFabric Hyperic Monitoring and Management describes how to use the VMware® vFabric™ 

Hyperic® and Hyperic HQ user interface, perform resource control actions, and process fired 

alerts. 

Intended Audience 
vFabric Hyperic Monitoring and Management is intended for operations personnel who monitor 

resources with Hyperic. 
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Use and Tailor the Hyperic Dashboard 

These topics describe the Dashboard component of the VMware vFabric™ Hyperic® user 

interface. 

 Introduction to the Hyperic Dashboard 

 Auto-Discovery Portlet 

 Availability Summary Portlet 

 Control Actions Portlet 

 Favorite Resources Portlet 

 Group Alert Summary Portlet 

 Metric Viewer Portlet 

 Problem Resources Portlet 

 Recent Alerts Portlet 

 Saved Charts Portlet 

 Summary Counts Portlet 

Introduction to the Hyperic Dashboard 

The Hyperic Dashboard is the first page displayed in the Hyperic user interface when you log 

on. The dashboard contains multiple portlets, each of which presents a particular type of 

information, such as resource health, recent alerts, recently discovered resource or changes to 

resources, recently performed resource control actions, and so on.  

You can personalize the dashboard to suit your responsibilities and preferences; you can add or 

remove portlets, rearrange them, and customize the contents of many of the portlets.  

In vFabric Hyperic, you can have multiple dashboards — one for each role to which you are 

assigned. For more information, see Using Multiple Dashboards in vFabric Hyperic. 

Note also that in vFabric Hyperic, the roles you are assigned to govern what resource data 

appears in dashboard portlets. Portlets will contain only the resource data to which your Hyperic 

roles allows access.
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Portlet Quick Facts and Links 

Portlet Description More Information and 

Configuration Options 

Autodiscovery Lists new and changed resources, and 

allows you to add them to inventory.  

Auto-Discovery Portlet  

Availability Summary Displays the availablility of selected of 

resources, aggregated by resource 

type. Refreshes every minute.  

 

This portlet does not contain any 

resources until you configure it. 

Availability Summary Portlet  

Control Actions Lists the control actions that Hyperic 

has most recently performed on any 

managed resource, upcoming 

scheduled control actions, and the 

most frequently performed quick 

control actions.  

Control Actions Portlet  

Favorite Resources Lists resources that have been added 

to the portlet.  This portlet does not 

contain any resources until you 

configure it. 

Favorite Resources Portlet  

Saved Charts Displays charts that have been saved 

to the Dashboard. In vFabric Hyperic, 

charts are displayed as a slideshow. 

Saved Charts Portlet  

Recent Alerts Lists the most recently triggered alerts 

for a set of user-selected resources. 

Refreshes every minute.  

Recent Alerts Portlet 

Recently Added  Lists platforms recently added to 

inventory.  

Recently Added Portlet 

Search Resources Portlet Allows you to search for resources. 

The search supports case-insensitive, 

partial-term queries and is restricted to 

a single inventory type. 

  

Summary Counts Displays a count of all the managed 

resource of each inventory type. In 

vFabric Hyperic, the resources that 

appear are limited to those that you 

have permissions to view.  

Summary Counts 
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Portlet Description More Information and 

Configuration Options 

Group Alert Summary  Displays traffic light indicators for 

resource alerts and group alerts for 

selected groups. Click on the traffic 

light for a group alert to view a list of 

alerts that have fired. Click on a group 

name to view the group page. This 

portlet does not present any groups 

until you add them to it. 

Group Alerts Summary Portlet  

Metric Viewer Shows selected metrics for selected 

resources. Refreshes every minute.  

 

This portlet does not contain any 

resources until they have been added 

to it. 

Metric Viewer Portlet  

Problem Resources Lists all resources with problem 

metrics, their availability, the number 

of alerts triggered on each, the number 

of times the metric has been out of 

bounds, and the last time the OOB 

metric was collected.   

 

Click the resource name to view the 

Monitor page for it. 

Problem Resources Portlet 

Tailor Dashboard 

You can customize the dashboard in these ways: 

 Add portlets — At the bottom of each column of portlet, click Add Content to this 

column to list portlets you can add. 

 Remove portlets — The top right corner of each portlet has a delete icon  you can use to 

remove it from your Dashboard. If you remove a portlet, you can add it back later — 

removed portlets can be selected from the list that displays when you click Add Content 

to this column. 

 Change layout — You move a portlet to a different location in a column by grabbing it by 

the bar at the top of it and dragging it to the desired location. 

 Change portlet behavior — Most portlets have a gear-shaped icon in the bar at the top, 

which you can click to display a configuration dialog. 

Using Multiple Dashboards in vFabric Hyperic 

In vFabric Hyperic, you can: 

 Select a dashboard — Select which dashboard to view using the Select a Dashboard 

pull-down in the upper left of the page. In addition to your personal dashboard, the list 

will contain the role-specific dashboard for each role to which you are assigned. 
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 Set a default dashboard — By default, your default dashboard is your personal 

dashboard. To change the default dashboard, select the desired dashboard, and click 

Make Default to the right of the Select a Dashboard pull-down — this control appears 

on a dashboard that is not currently your default dashboard.  

Auto-Discovery Portlet 

The Auto-Discovery portlet on the Hyperic Dashboard lists recently added or modified 

platforms and servers, and allows an authorized user to view discovery details, and to import 

the new or changed resource data to the Hyperic database. 

By default, the Auto-Discovery portlet lists the (up to) five most recently new or changed 

platforms. To set the maximum number of platforms that can appear in the list, see Configure 

the Number of Auto-Discoveries Displayed. 

A platform appears in the the Auto-Discovery portlet if it, or a server running on it, is new or 

changed. The rules are these: 

 The platform is new — A platform appears as new in the portlet, if neither its IP 

address or FQDN match that of an existing platform in inventory. In this case, any new 

servers discovered on the platform appear below the platform in the portlet.  

 The platform has a new server — A new server has been discovered on the platform 

since the last scan. The new server is listed below the platform. 

 Platform or server properties have changed — One or more inventory properties for 

the platform, or for one or more of the servers running it, have changed since the last 

scan. Servers with changed properties are listed below the platform. 

The image below shows the Auto-Discovery portlet after the agent was started for the first time 

on a platform. 

 

The Auto-Discovery portlet presents the following information for each platform it contains:  

 Hostname — The hostname of the platform is a link to a page — the Auto-Discovery 

Results page - that contains detailed information about the scan results for the platform 

and servers running there. See Using the Auto-Discovery Results Page. 

 Platform type — The resource type for the platform. 
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 Status — Indicates the type of change that was detected for a resource, either "new" or 

"modified". 

 Changes — If the Status for a resource is "modified", the Changes column contains a 

summary of what changed. For example: 

o "server set changed" — Applies to platforms; this value indicates that changes to 

one or more servers on the platform were detected. The changed server(s) are 

listed below the platform. 

o "name change" — Indicates that the name of the resource has changed; a resource 

name can change when a resource is upgraded from one version to another, if 

version number forms a portion of the resource name, as is often the case. 

o "install path changed" — Indicates that the installation path for a server has 

changed; the installation path for a resource can change when a resource is 

upgraded from one version to another, if version number forms a portion of the path, 

as is often the case. 

o "IP set changed" — Indicates that the IP address has changed. When the agent 

detects an IP address not associated with an existing platform in inventory, it 

checks for a platform with a matching FQDN - if found, Hyperic recognizes the 

platform as existing. 

o "FQDN changed" 

 For each newly discovered or changed server on the platform: 

o Installation path — 

o Status — Indicates "new" or "modified" 

o Changes — If Status is "modified", the Changes column contains a summary of 

what changed. 

About Discovery and Import of Services 

The Auto-Discovery Portlet does not display new or changed services.  Serviced are 

discovered during a run-time scan and are automatically added to Hyperic inventory. For 

more information, see Resource Auto-Discovery Processes. 

Import or Skip Resources in Auto-Discovery Portlet 

 You can process the contents of the Auto-Discovery Portlet in these ways: 

 To import all resources---leave all resources selected, and click Add to Inventory. 

 To skip all resources---leave all resources selected, and click Skip Checked 

Resources. 

 To import selected resources---Either: 

o De-select the resources you do not want to add to inventory, and click Add to 

Inventory, or 

o De-select the resources you do want to add to inventory and Skip Checked 

Resources. 
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About Skipped Resources 

If you do not import a resource displayed in the Auto-Discovery portlet, note: 

 If you skip a new platform, you skip its servers as well. 

 During the next platform scan, skipped resources will reappear in the portlet after the 

next scan that detects them. If you have resources that you do not want the agent to 

discover, see the relevant section in Options for Running and Controlling Resource 

Discovery. 

 

If the Hyperic Agent discovered all of the resource properties required to monitor a resource, 

it starts monitoring that resource as soon as you add it to inventory. This is the case for most 

resource types. Note however, that some level of configuration is required to start managing 

some resources types - see the Configuration Properties section on a resource's 

Inventory tab for configuration requirements. 

Configure the Number of Auto-Discoveries Displayed 

To set the number of completed auto-discoveries displayed in the portlet, click the gear icon in 

the upper left corner of the portlet. On the Display Settings page, select "10" or "all", and click 

OK. 

Availability Summary Portlet 

The Availability Summary portlet presents the availability of selected resources by resource 

type. The portlet is empty until you configure the resources to include. 

In the screenshot below, the portlet summarizes the available of 6 resources - five Linux 

platforms and one Win32 platform:  

 One Linux platform is unavailable, the other four are available.  

 The Win32 platform is available 

 

Configure the Availability Summary Portlet 

1. Click the gear icon in the upper right corner of the Availability Summary portlet. 

The HQ Dashboard Settings: Availability Summary page appears.  

2. In the Description field, enter the title to appear at the top of the portlet.  
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3. In the Display Range pulldown, select the maximum number of resource types to list in 

the portlet. 

4. If the Selected Resources section contains resources that you do not want to be 

included in the availability summary, checkmark them and click Remove From List. 

5. Click Add to List to add resources to the portlet: 

6. The Dashboard Settings: Availability Summary Add/Remove Resources page appears. 

7. In the Resources column: 

a. Use the View filters to filter by inventory type, resource type, or both, as desired. 

b. Enter a substring in the Filter by Name field to filter by resource name, as desired. 

c. In the list of resources, checkmark desired resources, and click the right arrow 

between the columns to include them in the availability summary.  

d. If the Add Resources column contains resources you do not wish to include in the 

availability summary, checkmark those resources and click the left arrow between 

the panels  

8. Click OK. 

Control Actions Portlet 

Learn About Control Actions 

For information about control actions, see: 

 Resource Control in Hyperic 

 Run Resource Control Actions 

 Configure a Custom Control Action 

The Control Actions portlet displays information about recent control actions performed on 

resources over a configurable period of recent history.  

 Recent Control Actions - This section lists the individual resource control action 

performed during the configured period, starting with the most recent.  The following 

information is displayed for each resource: 

o Resource Name — Name of the resource. 

o Control Action — The control action that was performed. 

o Date/Time — When the action was performed 

o Message — Results of the control action. 

 Quick Control Frequency - This section lists the resources upon which the most on-

demand control actions have been performed during the configured interval. The 

following information is displayed for each resource: 

o Resource Name — Name of the resource. 

o # of Control Actions — How many control actions were performed during the 

interval. 

o Most Frequent Control Action - The control action that was most frequently 

performed. 
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Configure the Control Actions Portlet 

To configure the amount of data in the Control Actions portlet: 

1. Click the gear icon in the upper right corner of the Control Actions portlet. 

The HQ Dashboard Settings: Control Actions page appears. 

2. Configure what appears in the Recent Control Actions section using the first row of 

filters. 

a. Check the box next Control Action Range if you want to list recent control actions in 

the portlet.  (To stop the display of this data, uncheck it.)  

b. In the first drop-down list, select the maximum number of completed control actions 

to list. 

c. In the second drop-down list, select the time range from which to gather that data.  

3. Configure what appears in the *Quick Control Frequency *section using the second row 

of filters:  

a. Check the box if you want to list the resources with the most on-demand control 

actions.  (To stop the display of on-demand control-action data, uncheck it.) 

b. Select the maximum number of resources to list. 

4. Click OK. 

Favorite Resources Portlet 

The Favorite Resources portlet lists the name, resource type, current availability, and total 

fired alerts for selected resources. 

Select a Favorite Resource On the Fly 

You can add a resource to Favorite Resources when you are viewing it in the Resources tab  

— click Add to Dashboard Favorites on the Tools menu. 

Configure Favorite Resources on the Dashboard 

1. Click the gear icon in the upper right corner of the Favorite Resources portlet. 

The HQ Dashboard Settings: Favorite Resources page appears. 

2. If the Selected Resources section contains resources that you do not want to be 

included in the portlet, checkmark them and click Remove From List. 

3. Click Add to List to add resources to the portlet: 

The Dashboard Settings: Favorite Resources: Add Resources page appears. 

4. In the Resources column: 

a. Use the View filters to filter by inventory type, resource type, or both, as desired. 

b. Enter a substring in the Filter by Name field to filter by resource name, as desired. 

c. In the list of resources, checkmark desired resources, and click the right arrow 

between the columns to include them in the portlet.  

5. If the Add Resources column contains resources you do not wish to include in the 

portlet, checkmark those resources and click the left arrow between the panels  

6. Click OK. 
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Group Alert Summary Portlet 

The Group Alerts Summary portlet displays traffic light indicators for resource alerts and group 

alerts for selected groups. Click on the traffic light for a group alert to view a list of alerts that 

have fired. Click on a group name to view the group page. This portlet does not present any 

groups until you add them to it. 

 

Configure the Group Alerts Portlet 

1. Click the gear icon in the upper right corner of the Group Alerts Summary portlet. 

The portlet refreshes. 

o The Available groups column lists compatible groups that have not been added to 

the portlet. 

o The Enabled groups column lists compatible groups that have been added to the 

portlet. 

2. Change the content of the portlet by clicking a group, and using the appropriate arrow to 

move the group from one column to another. 

3. Click save to save your changes. 

Metric Viewer Portlet 

The Metric Viewer portlet displays a selected metric for selected resources of the same 

resource type. The example below shows the current "Load Average 5 Minutes" metric for five 

Linux Platforms. 
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Configure the Metric Viewer Portlet 

1. Click the gear icon in the upper right corner of the Metric Viewer portlet. 

The HQ Dashboard Settings: Metric Viewer page appears. 

2. Specify the display settings for the portlet: 

o Description — This description shows up at the top of the portlet. 

o Display Range — The total number of resources to display in the portlet.  

o Resource Type — This selection filters both the set of resources that users can add 

to the portlet and the list of metrics available for selection. 

o Metric — The single metric that will be displayed for the user-selected set of 

resource in the portlet. 

o Sort Order — Determines whether the resources will be displayed in the portlet by 

descending or ascending metric value/ 

3. If the Selected Resources section contains resources that you do not want to be 

included in the portlet, checkmark them and click Remove From List. 

4. Click Add to List to add resources to the portlet: 

The Dashboard Settings: Metric Viewer: Add/Remove Resources page appears. 

5. In the Resources column: 

a. Enter a substring in the Filter by Name field to filter by resource name, as desired. 

b. In the list of resources, checkmark desired resources, and click the right arrow 

between the columns to include them in the portlet.  

6. If the Add Resources column contains resources you do not wish to include in the 

portlet, checkmark those resources and click the left arrow between the panels  

7. Click OK. 

Problem Resources Portlet 

The Problem Resources portlet on the HQ Dashboard lists resources that, over a configured 

period of recent history, have either had a fired alert, or an out-of-bounds metric. An out-of-

bounds metric is a metric that had a value outside the "acceptable" range of values set by the 

baselining process. 

Note: Tracking out-of-bounds metrics is a behavior that is configured globally, in the "Automatic 

Baseline Configuration Properties" section of the Administration > HQ Server Settings page. 

If tracking of OOB metrics is not enabled, OOB metrics will not cause a resource to appear in 

the Problem Resources portlet. 

The following information is shown for each problem resource: 

 Current availability of the resource. 

 Number of alerts that have fired during the historical period.  

 Number of out-of-bounds metrics reported during the historical period. 

Resources are ordered by inventory type (platform, server, and service), and then by the date 

and time of problem occurrence, from most recent to least recent. 
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Configure the Problem Resources Portlet 

You can use the HQ Dashboard Settings: Problem Resources page to limit the resources 

that are included in the Problem Resources portlet. 

1. Click the gear icon in the upper right corner of the Problem Resources portlet. 

2. The HQ Dashboard Settings: Problem Resources page appears. 

3. To limit the resources that appear in the portlet: 

o Show Maximum of — Select maximum number of problem resources to list. 

o For the Last — Choose the period of history for which to show problem resources. 

4. Click OK. 

Recent Alerts Portlet 

The Recent Alerts portlet presents a list of recently fired alerts. The following information is 

shown for each alert: 

 Date/Time - When the alert fired.  Click to view the Alert Detail page. 

 Alert Name - Name of the alert definition. 

 Resource Name - The resource where the alert fired. 

 Fixed - Whether the alert has been marked "fixed". 

 Ack - whether the alert has been acknowledged. 

Configure the Recent Alerts Portlet 

1. Click the gear icon in the upper right corner of the Recent Alerts portlet. 

The HQ Dashboard Settings: Recent Alerts page appears. 

2. In the Display Settings section: 

o Description — (optional) Enter a description, if desired. The description will appear 

at the top of the portlet. 

o Alert Range —  Select: 

 Maximum length of the alert list: 4, 10, 20 or 30. 

 The minimum priority of the alerts to include. 

 Timeframe of interest; choices range from 30 minutes to a month. 

 Resources of interest: 

 all resources - With this this setting, alerts (that meet the priority and 

timeframe criteria) on any resource can appear in the list. 

 selected resources - With this this setting, the alert list contains only 

resources listed in the Selected Resources section that meet the priority and 

timeframe criteria. 

3. If desired, define a set of resources of interest in the Selected Resources section. 
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The content of the portlet will be limited to alerts that fired on resources in the 

Selected Resources only when the "all resources/selected resources" switch is set 

to "selected resources". The contents of the Selected Resources section is ignored 

when the "all resources/selected resources" switch is set to "selected resources". 

a. If the the Selected Resources section contains resources not of interest, check the 

box next to them and click Remove from List. 

b. If you wish to add resources to Selected Resources click Add to List. 

The Dashboard Settings: Alerts Add/Remove Resources page appears. 

4. In the Resources column: 

a. Use the View filters to filter by inventory type, resource type, or both, as desired. 

b. Enter a substring in the Filter by Name field to filter by resource name, as desired. 

c. In the list of resources, checkmark desired resources, and click the right arrow 

between the columns to include them in the portlet.  

5. If the Add Resources column a contains resources that are not of interest, checkmark 

those resources and click the left arrow between the columns. 

6. Click OK. 

Saved Charts Portlet 

The Saved Charts portlet allows you to view charts of interest from the dashboard 

Charts are shown as a slideshow. 

 

Add Chart to Saved Charts Portlet 

 When you are viewing a chart, click Save to Dashboard. 
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Remove Chart from Saved Charts Portlet 

 Click Remove Chart button on the chart. 

Summary Counts Portlet 

The Summary Counts portlet on the HQ Dashboard shows resource counts by inventory type, 

and if configured to do so, counts for selected resource types. (For information about inventory 

and resource types, see Resources, Resource Types and Inventory Types). By default, the 

Summary Counts portlet shows the total resources of each inventory type — Application, 

Platform, Server, Service, Compatible Group, and Mixed Group — as shown in the screenshot 

below. 

Configure the Summary Counts Portlet 

To tailor the content of the Summary Counts portlet: 

1. Click the gear icon in the upper right corner of the portlet.  

The HQ Dashboard Settings: Summary Counts page appears.  

2. To exclude the count for a particular inventory type, (for instance, Applications) uncheck 

the "Show Total of All ..." checkbox for the inventory type. 

3. To show the count of resources of particular resource types, (for instance, WebLogic 

Admin 8.1 and MySQL 5.x), check the box next those resource types. 

4. Click OK. 

The screenshot below shows the Summary Counts portlet configured to exclude the 

count of applications, and to include counts for two server types: WebLogic Admin 8.1 

and MySQL 5.x 
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Monitor Resources in the Resource Tab 

These topics describe how to use the Resources tab component of the VMware vFabric™ 

Hyperic® user interface. 

 Browsing to Resources 

 Indicators Minitab 

 Metric Data Minitab 

 Resources Minitab 

 Metric Display Range 

 Charting Metric Data 

 Read a Full Page Chart 

 Tools Menu 

 Map Control 

 Metric Extrapolation View for Groups 

Browsing to Resources 

The first time you display the Resources > Browse page during a session, it lists the platforms 

in inventory, and the type, description, and current availability for each. See the screenshot 

below for an example.  To list resources of another inventory type, click the link for that type — 

Servers, Services, Compatible Groups/Clusters, Mixed Groups, or Applications — above 

the resource list. 

List Resources by Resource Type 

After you select an inventory type to list, a resource type selector list appears. The pulldown 

label depends on the currently selected inventory type, for example, All Platform Types, All 

Server Types, and so on. For example, in when screenshot below, the Platforms inventory 

type is selected, so a Platform Types pulldown is present. Select a platform type from the list to 

list only resources of that type. 

If the currently selected inventory level is Servers or Services, a pulldown list of resource types 

of the selected inventory type is present.  Select a resource type from the list to list only 

resources of that type. 
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If the currently selected inventory level is Compatible Groups/Clusters, a pulldown list labelled 

"Group Type" will appear. The list will contain resource types. If there is at least one compatible 

group of a resource type, that type will appear in the pulldown.  Select a resource type from the 

list to list only groups that contain that type. 

If the currently selected inventory level is Mixed Groups, a pulldown list labelled "Group Type" 

will appear. (See the pulldown to the right of the *Platform Types" list in the screenshot in List 

Resources by Resource Type). The entries in the list depend on the mixed groups configured in 

your environment. Select a group type from the list to list only groups of that composition. 

Depending on your deployment, the list may include: 

 Mixed Group - Platforms, Servers and Services 

 Mixed Group - Groups 

 Mixed Group - Applications 

Filter Platforms, Servers, and Services by Group 

When the currently selected inventory level is Platforms, Servers or Services, a pulldown list 

of groups appears. It lists both compatible and mixed groups to which you have access.  To list 

the platforms, servers, or services that are members of a particular group, select the group from 

the All Groups pulldown. 

Filter Resources by Name, Owner, and Availability 

You can apply additional filters the list of resources currently displayed. 

1. To filter by resource name, enter an alphanumeric string that matches all or a portion of 

resource name. 

2. Click the Unavailable box to filter the current list of resources to include only resources 

that are currently unavailable. 

3. Click the Owned by UserName box to filter to include only resources 

4. Click the green control to the right of the filter options to apply the filters.  
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Indicators Minitab 

The Indicators minitab contains a chart for each indicator metric for the currently selected 

resource. 

 

Availability Bar and Timeslices 

The bars across the top and bottom of the the tab — labelled "D" and "G" in the screenshot in 

the Overview of Indicators Minitab section — contain grey dots, each of which corresponds to a 

timeslice. The length of the timeslices depends upon the currently selected Metric Display 

Range — if the display range is 8 hours, each timeslice is 8 minutes. If the display range is 4 

hours, each timeslice is 4 minutes. The color of the dot for a timeslice indicates the availability of 

the resource during that timeslice. If the timeslice is longer than the collection interval for the 

metric, the availability shown for the timeslice is based on the multiple data points collected 

during the timeslice. 

 Green — indicates 100% availablility during timeslice — each time that availability was 

reported during the interval, the resource was available. 
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 Orange — indicates availability greater than 0% and less than 100% — during the 

interval, the availability of the resource was reported to be unavailabledata point during 

the interval was the resource was available 

 Red — indicates 0% availability during timeslice — each time that availability was 

reported during the interval, the resource was not available.  

The average availability over the display range is shown to the right of the availability bar.  

Click an availability indicator to display the start time of the timeslice, and a vertical bar to help 

you view the state of each metric during the timeslice.  

Metric Charts in the Indicators Minitab 

The Indicators page displays a chart of each of the resource's indicator metrics. (This portion of 

the page is labeled "E") in the screenshot in the Overview of Indicators Minitab section ---The 

values labeled LOW, AVG, and PEAK are the lowest, average, and highest values collected 

during the metric display range. 

The indicators are displayed as column charts: the area of each column indicates the value 

range (the high and low values) of the metric. The average value of the metric is indicated by 

the cross in the column. The charts are stacked vertically so that their X-axis (time) values line 

up. This works in conjunction with the vertical highlight from the availability and timeline bars to 

analyze the metric data across multiple metrics for a specific time. This is useful when trying to 

diagnose a problem at a specific time by correlating relevant metric values. Arrangements of 

charts for selected metrics can be saved as a "view" so that users can easily always compare 

the same metric data and therefore understand the interaction between different resources. 

 To change the display order of the charts, click the up and down arrow controls  at the 

upper-right-hand corner of each chart. 

 To remove a chart from display, click the red X icon at the upper-right-hand corner of the 

chart. 

 To save the set of displayed charts and their order, either 

o Update the current view: Select "Update <current-view name>" in View and click the 

icon. 

o Create a new view: Select "Create New View" in View, type a view name, and click 

icon!. 

 To delete the current view: Select "Delete View" in View and click icon.png!. 

 To display another view: Select "Go to View" in View and select one of the views. 

Event Icons and Popups 

A purple circular icon over a timeslice in the bar at the bottom of the Indicators pane indicates 

an event was logged occurred during that timeslice. Click an event icon to display details in a 

popup. 
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Resources Minitab 

For information about the Resources minitab on the left side of the page, see Resources 

Minitab. 

Metric Data Minitab 

The Metric Data minitab, available when an individual resource, or a group of resources of the 

same type are selected, is a tabular summary of the measurements collected during the 

currently selected metric display range. 

By default, the Metric Data minitab displays only metrics for which measurements exist during 

the metric display range. To list all metrics supported for the resource, click the control next to 

Show All Metrics at the top of the Metric Data minitab. 

When all supported metrics for a resource are listed, a Hide Metrics Without Data control 

replaces the Show All Metrics control - click the the control next to it to toggle the display. 

The columns in the Metric Data minitab vary, depending on whether an individual resource or a 

group of resources is selected, as described in the subsections below. 

Metric Data Minitab for a Single Resource 

The Metric Data minitab displays the following data for each metric that is enabled for one or 

more members of a compatible, over the current metric display range: 

 Alerts — Number of times a collected metric value triggered an alert.  

 OOB — Number of times the metric was out-of-bounds. 

 LOW — Lowest value collected. 

 AVG — Average of values collected. 

 PEAK — Highest value collected. 

 LAST — Last collected value. 

 Collection Interval — Frequency of metric collection. "NONE" indicates that data is not 

being collected.  

Metric Data Minitab for an Autogroup or Compatible Group 

The Metric Data minitab displays the following data for each metric that is enabled for one or 

more members of a group of resources of the same type — an autogroup or a compatible 

group. 

 Number Coll — Number of data points collected across all group members for which 

the metric is enabled. 

 Alerts — Number of times a collected metric value triggered an alert. 

 OOB — Number of times the metric was out-of-bounds across all group members. 

 LOW — Lowest value collected across all group members. 

 AVG — Average of values collected across all group members. 
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 PEAK — Highest value collected across all group members. 

 SUM — Sum of all values collected, not for a metric whose unit is percentage.  

 Collection Interval — Frequency of metric collection. 

o "NONE" — indicates that data is not being collected. 

o "VARIES" — Indicates that the collection interval varies among members of the 

group. 

 Member health data — (For compatible groups only, not autogroups) The lower portion 

of the Metric Data minitab for a compatible group lists the resources in the group, the 

current availability of each, and in the rightmost column. an icon that links to the Alerts 

page for the resource. 

Compare Metrics for Resources in a Compatible Group 

Check the member resources in "Current Health of group's <group name> resources collecting 

metrics" and click Compare Metrics of Selected at the bottom of the page.  and proceed to the 

"Compare Metrics" screen. 

View Metric Details and Metadata 

To display metric data for a single resource in a separate window, click the  log at the right end 

of metric data for the resource. 

Set Page Refresh Frequency 

To change the frequency with which the page refreshes, click a refresh value or OFF, in the 

Metric Refresh section in the upper right of the minitab. 

Tailor Metric Collection Settings for the Resource 

You can tailor the metric collection settings for the resource on the Metric Data minitab. 

Resource-Level Metric Collection Settings can Be Overwritten 

The default metric collection settings for a resource are specified on the Administration > 

Monitoring Defaults page for the associated resource type. You can alter the metric 

collection interval for a specific resource on its Metric Data minitab — note however that 

subsequent updates to the monitoring defaults for the resource type will overwrite any 

modifications to collection intervals made for a specific resource. For information about 

setting metric collection options for all resources of the same resource type, see the Tailor 

Metric Collection for a Resource Type page of vFabric Hyperic Administration. 

 

Modifying Metric Collection for a Group 

Changes to make to metric collection settings for a group will apply to all members of that 

group. 
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Disable Collection of a Metric 

5. Place a checkmark next to each metric you wish to disable. 

6. Click Disable Collection at the bottom of the minitab.   

Note: If the currently selected resource is a compatible group, collection of the metric is 

disabled for all resources in the group. 

Enable Collection of a Metric 

1. Click the arrow to the right of Show All Metrics at the top of the minitab. 

All metrics, including currently disabled metrics, will be listed.  

2. Place a checkmark next to each metric you wish to enable.  

3. To specify the frequency of metric collection: 

a. Enter an integer value in the Collection Interval for Selected field. 

b. Select "Minutes" or "Hours" from the pull-down list. 

c. Click the arrow to the right of the "Minutes/Hours" pull-down list. 

Note: If the currently selected resource is a compatible group, collection of the metric is enabled 

for all resources in the group. 

Set Collection Interval for a Metric 

1. If the Metric Data minitab currently display all metrics for the resource, including disabled 

metrics, click Hide Metrics Without Data.  

2. Place a checkmark next to the metric whose collection interval you wish to modify.   

You can checkmark more than one metric if you want to set the same collection interval 

for each of them. 

3. To specify the frequency of metric collection: 

a. Enter an integer value in the Collection Interval for Selected field. 

b. Select "Minutes" or "Hours" from the pull-down list. 

c. Click the arrow to the right of the "Minutes/Hours" pull-down list. 

Configure Metric Baselines 

You can use the Set Baselines control at the bottom of the Metric Data minitab to reset the 

baseline, acceptable high, and acceptable low values for a metric. For more information, 

Baselines and Configure Metric Baselines. 
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Resources Minitab 

The Resources minitab for a resource in the Resource Hub lists the resources with which the 

current resource has a parent or child relationship, as shown in the screenshot below. 

 

Resource Lists in the Resources Minitab 

For a.... the Resource minitab lists these related resources.... 

Platform  Platform Services Health ---List of plat form services running on the 

platform 

 Deployed Servers Health — List of servers running on the plat form.  

If more than one service or server of the same type runs on a host, 

they are presented as a single item in the appropriate list - an 

autogroup - whose name is the resource type. 

Server  Services  --- List of services running in the server.  If more than one 

service runs on a server, they are presented as a single item - an 

autogroup - whose name is the resource type. 

 Host Platform --- Plat form where the server runs. 

Service  Host Server --- Server where the service runs.  

Compatible Group Group Members --- List of resources in the group, and either:  

 Host Platforms --- If the compatible group contains servers, this 

section lists each platform upon which one or more group member 

runs.  

 Host Servers --- If the compatible group contains services, this 

section lists each server upon which a group member runs.  

Applications   Services  --- List of the services that the server comprises.  If the 

application contains more than one service of the same type, they 

are  presented as a single item in the Services list - an autogroup - 

whose name is the resource type. 

 Host Servers --- Lists each server upon which a service in the 

applications runs.  
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Availability Icons in the Resources Minitab 

The color of the icon in the Availability column indicates the current availability status of the 

resource, or the resource group. 

Availability Icon 

Color 

Availabilit

y Icon 

State Definition 

Green  
 

Up For an individual resource, indicates that its 

availability status is "up". 

 

For a group, indicates that none of the group 

members has availability status of  "down".  

Yellow 
 

 

Warn This state is valid for a group only. It indicates 

that (1) one or more group members, but not all 

members, have the availability state of "down", 

and (2) the remaining members have status 

"green". 

Blue 
 

 

Maintenance/Paused This icon appears only for a VM or a group of 

VMs. 

 

For an individual VM indicates it is paused.  

 

For a group, indicates that all VMs in the group 

are paused. 

Red  
 

Down For an individual resource, indicates that its 

availability status is "down". 

 

For a group, indicates that all members of the 

group have either availability status "red" or 

"unknown".  

Grey  
 

 

Unknown For an individual resource, indicates that its 

availability is unknown.  

 

For a group, indicates that the availability of at 

least one of the members is unknown.  

Blue  
 

Suspended/Powered 

Off 

This icon appears only for a VM or a group of 

VMs. 

 

For an single VM indicates it is suspended or 

powered off. 

 

For a group of VMs, indicates that all VMs in the 

group are suspended or powered down.  
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Availability Details in the Resources Minitab 

Hover over the  callout icon for more information about the resource. The information 

displayed in the popup varies by resource type. 

For a... the popup contains Example 

Platform, Platform Service, 

Server, or Service 

 Inventory level and resource type 

of the resource.  

 Last known throughput metric 

value for the resource.  
 

 

Autogroup  Inventory level and resource type 

of the resource.  

 Breakdown of resources 

availability by availability status 
 

 

Compatible Group  Resource type for the resources 

in the group 

 Last known throughput metric 

value for the group.  

 Go to Resources link — Click to 

expand the group and see a list 

of its members. 

 
 

Metric Summaries in the Resources Minitab 

When the Indicators minitab is selected, you can use the controls in the Resources minitab on 

the left side of the page to display information about  metrics collected for the current resource 

and resources directly related to it. 

You checkmark one or more of the resources listed in the Resources minitab, and then choose 

All Metrics or Problem Metrics to display all available metrics, or only those with 

measurements that were out-of-bounds or fired alerts during the metric display range. When 

you click View Metrics the metrics that meet your are listed. 
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For example, in the screenshot below, the Resources minitab lists all of the metrics collected 

for the current platform, and all of the metrics collected for a Tomcat server running on the 

platform. The OOB and Alerts columns for a metric show how many times the metric was out-

of-bounds or fired an alert 

 

View Metric Data for Related Resources in the Resources Minitab 

1. Checkmark the box next to each resource for which you wish to display metrics. 

2. Filter metrics as desired: 

o Problem Metrics — Only metrics whose values are outside the expected range 

established via the baselining process will be listed.  For each metric, the portlet 

displays two counts: the number of the selected resources that have "OOB" values 

for the metric, and the number of "Alerts" that the metric value has triggered 

o All Metrics — The indicator metrics for selected resources will be listed - 

regardless of whether they are out of bounds. 

3. Click View Metrics. 



30 

Use Controls and Popup Options in the Resources Minitab 

When you use the View Metrics option described in the previous section to list metrics, two 

controls are available for each metric, to the right of the Alerts column. 

1. Hover over the callout icon next to a metric to display a popup menu of options.  

o Click Chart Metric in Indicators to add a chart for the metric to the chart pane to 

the right. 

o Click View Full Chart to view a full page chart for the metric. 

o Click Metric Data to display the Metric Details and Metadata for the metric in a 

new window. 

Filter Metrics by Category and Value Type 

When the Metric Data minitab is active, rather than the Indicators minitab, the Resources 

minitab provides filtering options. 

1. Uncheck a metric category — Availability, Throughput, Utilization, or Performance — to 

exclude metrics of that type from the list of metrics. 

2. Value Type - Uncheck a value type - Dynamic, Trends Up, Trends Down, or Static — to 

exclude metrics with that value type from the list of metrics. 

3. Click the green arrow control to filter the list. 

Metric Display Range 

By default, the last 8 hours of history are presented on the Indicators page and other views in 

the Monitor tab. There are two ways to change the display range. 

Select a Number of Minutes, Hours, or Days 

Use the pulldowns in the Metric Display Range section of the page  to select a numeric value 

(available choices range from 4 to 120) and a unit of time (minutes, hours or days), and click the 

green right-arrow to refresh the page. 

Advanced Settings for Metric Display Range 

For more control over the display range, click Advanced Settings in the Metric Display Range 

section of the page. On the popup that appears, either: 

 Click Last, enter a number, and select a unit of time (minutes, hours or days) and click 

REDRAW, or 

 Click Within a Date Range, and use the pulldowns and fields to designate the start and 

end of the desired display interval, and click REDRAW. 

After the page is redrawn, the Metric Display Range section shows the currently selected 

range.  You can use the Show Last 8 Hours to return to the default display range, or Edit 

Range to display the Advanced Settings popup and choose a different display range. 
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Charting Metric Data 

A metric chart is a graphical representation of the metric data that Hyperic HQ collects for each 

resource. Each resource type supports a different set of metric data, so charts vary by resource 

type also. Charts can help you see trends in resource behavior, which can in turn be helpful for 

capacity planning, cost analysis, and other operational decision-making. 

HQ displays all full-page metric charts on the "Metric Chart" page, where you can adjust how 

the metric is displayed. (Indicator charts are more minimally displayed on the "Current Health" 

screen.) Consult the help for those screens for the nitty gritty about viewing and interpreting 

charts. 

Chart Types - What They Are and How to View Them 

There are three kinds of charts, and each gives you a different perspective on resource health. 

For any chart, you have to select the metrics to be charted: this selection occurs on the "Current 

Health"" screen for the resource (or for the parent group if looking at multiple resources), on the 

 tab, on the  tab, which lists all the metrics collected for the resource 

being viewed. The chart of the selected metric(s) is displayed on the "Metric Chart" screen. 

Type Description 

Single Metric Single Resource This chart shows a single metric for a single resource.  

To chart a single metric: 

 On the  tab, click the name of the 

metric or  next to the metric whose chart you want 

to see. 

Another way to view the chart page for a metric for a 

single resource is from the  tab on the 

monitor visibility pages. If an indicator chart 

represents a metric for a single resource, clicking on 

its name will also display the full chart page for that 

metric and resource.  

Multiple Metrics Single Resource This chart shows up to a maximum of ten metrics 

simultaneously for a single resource, which is handy for 

getting an overall sense of the resource's health.  

To chart multiple metrics for a single resource:  

 On the  tab, check the names of the 

metrics you want to chart and click 

. 

The  tab also displays multiple metrics 

for a single resource. See the help for the "Current 

Health" screen for an explanation.  



32 

Single Metric Multiple (Group) Resources  This chart shows a single metric for a maximum of ten 

resources, which allows you to compare the behavior of 

different resources. The resources must be members of a 

single compatible group  or of a single autogroup.  

 To chart a single metric for multiple resources of 

a compatible group: 

a. On the  tab, click the name of 

the metric or  next to the metric whose 

chart you want to see.  

A full-page chart is displayed with data from 

the first 10 resources listed on the 

 tab. 

b. To change the set of resources displayed in 

the chart, on the "Metric Chart" screen, 

check or uncheck the desired resources in 

"Participating Resources" and click 

 
The chart will be refreshed to reflect metric 

data from the new set of resources. 

 To chart a metric for multiple members of an 

auto group: 

a. Navigate to the parent resource that 

contains the auto group.  

b. From the parent resource's "Current Health" 

screen, click the subtype. 

The "Current Health" screen for the auto 

group of that subtype is displayed. 

c. On the  tab, click the name of 

the metric or  next to the metric whose 

chart you want to see.  

To view the chart for an indicator metric: 

 Instead of the  tab, on the  tab, click the name of the indicator 

metric above the chart. 

A full-page chart is displayed. 

How a Chart is Constructed 

A metric chart by default displays only the measured metric data values over a user-selected 

time frame. You can also chart peak (highest observed), lowest and highest acceptable, and 

average values, and you can change the time frame that the chart covers. If you are charting a 

single metric for a single resource, you can also establish and chart baseline values. Depending 

on the display rangeover which you are charting the metric data and whether the metric data is 

cumulative (for example, throughput), the values may be averaged over time. 

For more information about reading a chart, read the help for the "Metric Chart" page. 
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Read a Full Page Chart 

Contents of a Full Page Chart 

Observed Measurements 

Each bar on a chart represents a timeslice that is 1/60 of the selected metric display range. A 

chart can plot a maximum of 60 points. The value of the Y-axis at the top of the bar is the 

observed metric value for that timeslice. What the value represents varies by the nature of the 

metric: 

 Static — For a static metric, one whose value does not vary over time (for instance a 

timestamp), the plotted value corresponds to a single measurement. 

  

 Dynamic — For a dynamic metric, one whose value may go up or down over time:  

o The plotted point is the average of the values collected over the timeslice that 

ended at the time shown for the bar in the  X-axis. The length of time over which the 

value was averaged depends on the current metric display range. For a display 

range of eight hours, each charted point represents the average of the preceding 

eight-minute period (8 hours / 60 time slices along the X-axis = 8 minutes). If the 

metric is collected every 60 seconds, and the chart's display range is 60 minutes, 

each of the 60 plotted points on the graph represents the single, observed value for 

the metric at a single point in time. 

o The I-bar superimposed on the vertical bar shows the range of values collected 

during the timeslice. 

 Trends Up and Trends Down — For a cumulative metric, one whose values either 

always increases or decreases, (such as bytes served, uptime, minimum response 

time), the plotted point is the maximum (or minimum) value for the time slice. The value 

shown for a metric that for trends up or down metrics is not the average over the 

timeslice. 
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More About Timeslices 

Charts are divided into a maximum of 60 slices, where each slice represents the same 

amount of time, over any display range the user chooses. For example: 

 If the charted metric's collection interval is 5 minutes and the selected metric display 

range is one hour, during which the metric value was collected 12 times, the chart will 

contain 12 time slices, and each slice will represent a single observed metric value.  

 If the metric display range is 5 hours, during which the metric value was collected 60 

times, the chart will display 60 time slices, each will represent a single observed 

metric value. 

 If the selected display range is 10 hours long, during which the metric value was 

collected 120 times, the chart will display 60 timeslices – the maximum — and each 

bar will summarize the 2 data points collected during the timeslice. For dynamic 

metrics, data points are averaged. For trends up or down metrics the highest/lowest 

value is plotted. 

Peak, Average, and Low Values 

By default, three colored horizontal lines appear on a metric chart that show the peak (pink), 

average (green) and low (blue) values collected for the metric for duration plotted.  

Baseline and Acceptable High and Low Values 

In vFabric Hyperic, this additional information may appear on a chart: 

 Baseline — The baseline value for the metric is shown as a tan horizontal line.  

 Low Range — A pink horizontal bar appears across the chart, between the low range 

value and the maximum value shown on the chart's Y-axis. 

 High Range — A green horizontal bar appears across the chart, between the high range 

value and the minumum value shown on the chart's Y-axis. 

Learn About Baselines 

See Baselines and Configure Metric Baselines. 

Participating Resources 

This section lists the resource and its metrics or the resources (if you are charting metrics for a 

group) that are plotted in the chart. Users can change the individual resource's metrics or the 

set of group member resources that are included in the chart. 

Metric Baseline and Expected Range 

This section allows the user to view and change the values current calculated or set for the 

metric baseline  and the acceptable range of metric values (outside of which observed metric 

values will be considered out-of-bounds (OOB). This section is available only when a single 

metric is charted. 



35 

Filter Chart Data 

The chart legend allows users to select types of data to include in the chart: 

 Actual: The observed metric value at any point in time 

 Peak: The highest observed metric value (this will be a horizontal line)  

 Average: The average of observed metric values across the entire graph (this will be a 

horizontal line) 

 Low: The lowest observed metric value (this will be a horizontal line) 

 Low Range: The user-specific lowest acceptable metric value (this will be a horizontal 

line) 

 High Range: The user-specific highest acceptable metric value (this will be a horizontal line) 

 Baseline: The HQ- or user-set baseline value (this will be a horizontal line) 

 Control Actions: Indicates on the chart when control actions where performed on the 

resource (to help correlate the actions with changes in performance) 

Change Metric Display Range 

 At the bottom right of the "Metric Chart" section, either: 

o To move forward or back eight hours, click the back-arrow or the forward-arrow, 

respectively. The new display range is indicated. 

o For a specific date/time range: 

i. Click Edit Range. 

ii. For a range counting back from the current time: Select a length of time. 

iii. For a date/time range: Select a date/time range. 

iv. Click Redraw. 

The metric charts on the screen automatically refresh to reflect the new display 

range. This display range value applies to all resource-monitoring screens. 

Save Chart to Dashboard 

 At the top of the page, click Save Chart to My Dashboard, to add the chart to the "Saved 

Charts" portlet in the dashboard. 

If you have edit permissions for multiple dashboards, the Tools menu will instead have an 

Save Chart to Dashboards option. Select the option to view a list of dashboards for which 

you have edit permissions. You can select one or more dashboards, and click Add to add 

the chart to those dashboards. 

Save the Chart in CSV Foromat 

 At the top of the page, click Export to CSV. 
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Tools Menu 

The Tools menu that appears on every page in the Browse tab in the HQ user interface  contains 

commands you can perform on the currently selected resource type. The commands available vary 

depending on whether the current resource is a platform, a server, a service, and so on. Most of the 

commands on the Tools menu relate to managing resource inventory:  creating, configuring, and 

deleting resource; for platforms you can enable and disable alert definitions; for compatible groups, 

you can schedule downtime - a period during which alerts on resources on the platform of the 

servers and services that run in it will not fire. 

The commands that appear in the Tools menu vary depending on whether you are viewing a 

particular platform, server, service, group, application, or a list of resources on the Resources > 

Browse page. 

Most of the commands on the Tools menu relate to managing resource inventory:  creating, 

configuring, and deleting resources.  The Tools menu for a platform also has options for enabling or 

disabling alerts on the platform;  the menu for a compatible group has an option for scheduling 

maintenance downtime - a period during which alerts on resources on the platform and its 

dependent resources will not fire. 

The following table lists the commands on the Tools menu for each inventory type. 

Inventory Type  Tools Menu Options 

Platform  Configure Platform  

 Clone Platform  

 Delete Platform  

 New Server  

 New Platform Service  

 New Auto-Discovery  

 Enable All Alerts On This Agent  

 Disable All Alerts On This Agent  

 Add to Dashboard Favorites  

 Add to Group  

 Configure Platform  

 Clone Platform  

 Delete Platform  

 New Server  

 New Platform Service  

 New Auto-Discovery  

 Enable All Alerts On This Agent  

 Disable All Alerts On This Agent  

 Add to Dashboard Favorites  

 Add to Group 
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Server  Configure Server   

 Delete Server   

 New Service  

 Add to Dashboard Favorites   

 Add to Group 

Service  Configure Service  

 Delete Service  

 Add to Dashboard Favorites   

 Add to Group 

Group  New Group  

 Delete Group  

 Add to Dashboard Favorites   

 Add to Group  

 Schedule Downtime 

Application  Delete Application  

 Add to Dashboard Favorites   

 Add to Group 

none If no resource is selected, for instance on the on the  

Note: If no resource is currently selected, for instance on Resources > Browse > Platforms > 

All Platforms, the Tools menu has these options: 

 New Application 

 New Group 

 New Platform 

Map Control 

The Map control, available when a resource is selected in the HQ user interface - presents 

graphical view of the current resource and resources that are related to it. The map illustrates 

hierarchical inventory relationships, and a resource's membership in groups or applications. 

A resource map shows the name and resource type of currently selected resource in orange 

font. Child or member resources are shown above the selected resources; parent or containing 

resource is shown below. 

In the example below, note that: 

 The name of the currently selected resource is in orange font. In the example, the 

resource is a server type:  "ActiveMQ Embedded 5.3". 

 The resources listed above the current resource are its children --- assuming it has 

children.  If the currently selected resource is a service type, it would not have children.    

 The resource below the current resource is its parent --- assuming it has a parent.  If the 

currently selected resource is a platform type, it would have no parent.  

Each resource name is a link; click the link to navigate to the Indicators page for that resource.   
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The resource type for each resource is shown below the resource name. 

You can map a: 

 platform 

 server 

 service 

 compatible group 

Resource Map for a Platform 

The screenshot below is a resource map for a platform of type "Linux", shown in orange. The 

resources listed above the platform are the 9 servers running on it.  

 

Resource Map for a Server 

The screenshot below is a resource map for a server of type "ActiveMQ Embedded 5.3".  

 The resources listed above the server are the six services that run it it.  

 The resource shown below the service its parent platform — whose resource type is 

"MacOSX". 
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Resource Map for a Service 

The screenshot below is a resource map for a service of type "ActiveMQ Embedded 5.3 Topic". 

 The service runs in an "ActiveMQ Embedded 5.3" server, which is hosted on a 

"MacOSX" platform 

 The service is part of an application called "myap". 

 

Resource Map for a Compatible Group 

The screenshot below is a resource map for compatible group that contains servers of type 

"VMware VI3 VM" - the name of each member resource is shown as a hyperlink.  

 

Metric Extrapolation View for Groups 

This page allows you to predict future values of a metric for the members of group based on 

historical metrics.  

The Metric Data Extrapolation plugin is available on the Views tab when a group is selected. 

Although this function is available for any group, whether compatible or mixed, metric 

projections are most meaningful for compatible groups. 

The extrapolation method is a simple linear regression using the Apache Commons Math 

package. The historical metric data for a group is used to calculate a slope, which is used to 

predict future values. 

To extrapolate a metric for a members of a group: 

1. Navigate to compatible group of interest. 

2. Choose the Metric Data Extrapolation option from the Views tab.  

3. You can select: 

o Metric to extrapolate.  By default, Availability is selected. If desired, choose another 

metric. 



40 

o Known Data Range. The amountof history upon which the extrapolation will be 

based. You can select values ranging from 1 day to 1 year. Typically, a longer data 

range yields a better extrapolation. In some cases, however, it might be better to 

select the data range based on the timing of environment-related events, such as a 

new release or infrastructure change. 

o Projection Range. The total duration included in the trend analysis, including the 

Known Data Range and the Projection Range. The range you select determines, 

but is not equal to, how far into the future the metric will be projected. 

o Threshold value for the metric. Charts will display a horizontal line at the metric 

value you enter. 

4. Click Update to plot the extrapolated values for the selected metric for each member of 

the Group. Historical values are plotted in blue. 

Understanding Extrapolation Charts 

Each chart has the same scale, to better show differences between the resources, and ease 

analysis. This is different from other HQ charts which are scaled independently. The heading for 

each chart shows: 

 The resource name and metric charted 

 The units of the metric charted 

 Extrapolation confidence; values can be 'Excellent', 'Good', 'Average', 'Questionable', or 

'Poor'. 

Extrapolated values are represented by the orange triangle that appears between "now" and the 

end of the projection range on the timeline. 
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Global Management Views 

These topics describe pages in the VMware vFabric™ Hyperic® user interface that provide 

deployment-wide views of resource status. 

 Alert Center 

 Event Center 

 Currently Down 

 Operations Center 

 Nagios Availability 

 Report Center 

Alert Center 

The Alert Center page is a deployment-wide view of alerts and alert definitions 

View Alerts In the Alert Center 

1. Click the Analyze tab. 

The Alert Center page appears, with the Alerts tab selected. 

2. The Alerts page displays the following data for each fired alert that matches the 

currently selected filter criteria, ordered chronologically. 

o Date — The date and time the alert was triggered. 

o Alert Definition — The name of the alert definition that prompted the alert. 

o Resource+ — The resource the alert was triggered on. 

o Fixed — Whether or not the alert was fixed. 

o Acked by — The name of the user who acknowledged the alert.  

o Priority — The alert's priority. 

3. Click a column heading to sort the table by the content of that column. 

Filter Alert List 

These are the options for filtering the list of alerts, and their default settings: 

Option Description Values Default Setting 

Show Filters the list of alerts by state.  Not Fixed 

 In Escalation 

 All 

All 
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Option Description Values Default Setting 

Alert type Filters the list of alerts by the 

type of target resource.  

 Resource — With this 

setting, only alerts fired 

on individual resources 

will appear. This includes 

alerts applied at the 

resource type level.  

 Group — With this 

setting, only alerts that 

fired on resource groups 

appear. 

All 

Minimum Priority Filters the list of alerts by the 

priority of the associated alert 

definition.  

 Low 

 Medium 

 High 

Low 

In the last  Limits the list to alerts fired with a 

recent period of time. 

 All Time 

 day  

 2 days 

 3 days 

 4 days 

 5 days 

 6 days 

 week 

All Time 

Groups Limits the list of alerts to those 

fired on resources in a group.  

The pulldown lists every 

resource group (whether 

compatible or mixed) in the 

deployment, and the options "All 

Groups". 

All Groups 

Fix or Acknowledge an Alert in the Alert Center 

To mark alerts "Fixed" from the Alert Center page, and (in vFabric Hyperic) to acknowledge an 

alert in escalation, checkmark the desired alerts, and click Fixed or Acknowledge at the bottom 

of the page. 

View Alert Definitions In the Alert Center 

The Definitions tab on the Alert Center page lists alert definitions in your deployment — 

resource alerts, resource type alerts, and group alerts — that match the current filter criteria. 

1. Click the Analyze tab. 

The Alert Center page appears, with the Alerts tab selected. 

2. Click the Definitions tab to display the "Resource Alert Definitions" pane. 

The "Resource Alert Definitions" pane displays the following data for each alert definition 

that matches the currently selected filter criteria, ordered by creation date, with most 

recently created definitions first. 

o Name — The alert definition's name. Click to view the alert definition in the 

Resource Hub. 



43 

o Created — Date and time the alert was defined 

o Modified — Date and time the alert was modified (if at all)  

o Active — Whether or not the alert definition is configured to generate alerts) or not. 

If the alert is defined to fire once, and not again until after it is fixed, an yellow flag 

icon will be displayed in this column if the the alert is not fixed.  

o Last Alert — Date and time the alert was last triggered. Click to view a list of alerts 

that fired for the alert definition. 

o Resource — The resource, resource type, or group for which the alert was defined.  

Click to view the Monitor tab for the resource in the Resource Hub. 

o Escalation — The name of the escalation scheme assigned to the alert definition. 

Click to view the escalation. 

o Priority — The alert definition priority. 

Click a column heading to sort the table by the content of that column. 

Filter Alert Definition List 

These are the options for filtering the list of alerts, and their default settings: 

Option Description 

Definition Type Filters the list of alert definitions by whether the definition 

was for an individual resource, a group of resources, or a 

resource type target — so you can limit the list to definitions 

assigned to a resource, or to a resource type. Values are:  

 Resource — To list all alert definitions that assigned 

to individual resources or to a resouurce type.  

 Group — To list only alert definitions defined for a 

resource group. 

 Resource Type — To list only alert definitions that 

are assigned to resource groups. 

Exclude Type-Based Definitions  This option is available only when "Resource" is selected for 

"Definition Type" — checkmark to exclude resource type 

alert definitions from the list. 

Show Only Disabled Definitions  Further limit the definitions listed to those that are currently 

disabled. 

Event Center 

The Event Center page, available on the Analyze tab in the Masthead, is a deployment wide 

view of events that have been logged for resources in your Hyperic deployment.  

Learn about Events in Hyperic 

Hyperic logs alerts as events automatically. You can configure Hyperic to log events for log 

messages and resource configuration changes. For more information see Log and 

Configuration Event Tracking. 
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Events are ordered by date, with most recent events first. To reverse the sort order, click the 

control in the Date column header. 

Click  at the top right to refresh the list. 

Filter the Event List 

To limit the events displayed in the Events section, choose one or more filter options.  

 Minimum Status — Select a status to limit the log tracking events in the list to those of 

that level or higher. Log tracking event levels, in decreasing order of severity, are:  

o Error 

o Warning 

o Info 

o Debug 

 Type — Select a type to limit events in the list to those of that type: 

o Log track 

o Event Track 

o Alerts  

 Time Range — Select on the following time ranges to limit th events in the list to those 

occurred during the range: 

o Last 4 hours 

o Last 8 hours 

o Last day 

o Last week 

o Last month 

 Groups — Select one or more groups to limit the events in the list to those related to 

resources in the selected group(s). 

Contents of the Event Center Page 

The following data is shown for each event that matches the filter criteria selected in the Filter 

pane: 

The following information is shown for each event in the list: 

 Date — Date and time the event happened 

 Status — For log track events, the level is shown. For alerts, the status column contains 

"alert". 

 Resource — The name of the resource that caused the event 

 Subject — 

o For an alert, the alert name. 

o For a configuration tracking event, the type of change: "add", "delete", "modify", or 

"rename". 

 Detail — Information about the event detail or triggering condition. 

o For a configuration tracking event, a limited portion of the raw "diff" detected. For 

folder changes the diff contains a list of changed files. 
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Currently Down 

The Currently Down Resources page, available on the Resource tab is lists resources that 

are not currently available, up to a maximum of 1000 resources. 

Contents of the Currently Down Page 

The right pane of the Currently Down Resources pane lists resources that match the filter 

criteria selected in the "Resource Types" panel on the left, ordered by Down Time, from longest 

to shortest. Click a column header to sort by that column's contents — except for the "Alerts" 

column. 

By default, the page will list up to 50 resources. You can choose to list up to 100, or up to 1000, 

using the Show Most Recent control. 

The following data is shown for each resource on the list: 

 Resource — Name of the down resource. Click to view the resource's Indicators page. 

 Type — The resource's platform, server, or service type. 

 Down Since — The time at which the resource became unavailable. 

 Down Time — The length of time the resource has been unavailable. 

 Alerts — Click the icon in this column to see a list of alerts fired for the resource.  

Click  at the top right to refresh the page. 

Filter Resources of the Currently Down Page 

1. To list all currently unavailable resources of a particular inventory level click one of the 

top level links in Resource Types pane: 

o Platforms 

o Servers 

o Services 

2. To further narrow the list to unavailable resources of a particular resource type, expand 

the link for the inventory level, and click select the desired resource type from list that 

appears. 

Operations Center 

The Operations Center page, available on the Analyze tab in the Masthead lists resources 

that are down, have unfixed alerts, or both. You can use filters to scope the content of the page 

to the resources and problem type of interest. This concise view includes shows the current 

number of unavailable resources and unfixed alerts, and a single line problem summary for 

each resource. 
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Filter by Problem Type and Resource 

Use the "Display Filters" fields in the upper left of the page to specify the issues and resources 

to include in the page: 

1. Select a "Status Type": 

o All — list every resource that is currently unavailable or has an unfixed alert.   

o Down Resources — list only resources that are currently unavailable. 

o All Alerts — list all resources with unfixed alerts. 

o Alerts in Escalation — list resources with unfixed alerts that are currently in 

escalation. 

o Alerts not in Escalation — list resources with unfixed alerts that are not in 

escalation. 

2. To further limit the resources included in the page by hosting platform, enter a string in 

the "Platform Filter" field and press Return or Enter to update the page. 

The list includes resources with the selected "Status Type" that run on the platform(s) 

whose names match the specified "Platform Filter" string.  

3. To further limit the resources included based on group membership, select a group from 

the "Group Filter" pull-down. 

The list includes resources with the selected "Status Type", that run on platforms whose 

names match the "Platform Filter" (if specified), and belong to the selected group.  

Set Table Controls 

Use the Table Controls to specify the number of resources listed per page and the frequency 

with which the page content is updated. 

Contents of Operations Center Page 

The Operation Center page contains summary and detailed information for the alert or 

availability events that match the current "Display Filter" settings.     

Current Filter Totals 

The tables in the "Current Filter Totals" section summarize the results that match the current 

filter settings: 

 Resources table - Current number of unavailable platforms and the current number of 

unavailable resources of any type - platform, server, or service. If the current Status 

Type selection limits the page to alerts, the count column contains "N/A".  

 Alerts table - Total number of unfixed alerts and number of unfixed alerts in escalation, 

broken down by alert priority. If the current Status Type selection limits the page to alert 

events, the cells contain "N/A". 
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Resource Details for All Hosts 

Each row in the table in the lower part of the Operations Center page represents a resource 

that is currently down or a resource that has an unfixed alert.  If a resource is currently down 

and has an unfixed alert, it will appear in two rows. 

 Platform - The platform where the resource runs. 

 Resource - Name of the resource that is unavailable or has an unfixed alert.  

 Alert Name - In a row for a resource with an alert, the name of the alert definit ion that 

fired the alert. 

 Priority - In a row for a resource with an alert, the alert priority. 

 Status Type - Indicates whether the row corresponds to a "Resource Down" event or an 

unfixed "Alert". 

 Last Escalation - In a row for a resource with an alert in escalation, timestamp for the 

last escalation step performed. 

 Last Check - For an unavailable resource, shows when metrics for the resource were 

last collected. For an alert, shows when it last fired. 

 Duration - Indicates how long ago the alert fired or the resource went down. 

 State - For an alert, a  icon indicates the alert is in escalation. A  icon indicates the 

alert in escalation has been acknowledged. 

 Status Information - For an alert, shows how many times it has fired and the condition 

that triggered it. If a metric condition triggered the alert, the triggering and current values 

of the metric are shown. 

Report Center 

vFabric Hyperic's Report Center has built-in reports that provide visibility into availability, alerts, 

inventory, resource utilization, and resources that are not collecting metrics. You can also create 

your own reports. Report Center reports can accept parameter values, and be generated in 

PDF, HTML, Excel, and CSV formats. 

Report Center Requires Super User Role 

Only a user with the Super User role may run reports in the Report Center. For information 

about roles, see User Accounts and Roles in Hyperic. 

Navigate to the Report Center 

Click Analyze > Report Center. 
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Built-In Reports 

The table below describes the ready-to-run reports in the Report Center. Hyperic provides the 

following report templates: 

Report 

Template 

What Does It Tell 

Me? 

What The Report Displays Required User 

Input 

(Parameters) 

Sample Report 

Alert Detail  Which resources in 

my environment are 

firing the most 

alerts? 

The same as the Alert 

Summary Report, except, 

instead of a summary of 

alerts, every alert is shown. 

This is useful when analyzing 

a full alert log.  

Start Date 

 End Date 

 Group 

Alert Detail 

Report.png 

Alert Summary 

 

Which resources in 

my environment are 

firing the most 

alerts? 

A summary of all alerts that 

were triggered during the 

user-specified time range. You 

can restrict the list of alerts by 

a user-specified group. For 

each resource, the number of 

low-, medium-, and high-

priority alerts are shown, along 

with the total number of alerts. 

Start Date 

 End Date 

 Group 

Alert Summary 

Report.png 

Availability 

Downtime 

How many minutes 

were resources 

unavailable over the 

given time range? 

Availability percentage and 

minutes of downtime, over a 

user-specified time range, for 

resources in a user-specified 

group. This report cannot be 

run against the entire 

environment. 

Start Date 

 End Date 

 Group 

Availability 

Downtime 

Report.png 

Disk Usage Which disks are 

running low on free 

space? 

 Which disks are 

filling up the 

quickest? 

Disks in the environment that 

are running low on free space, 

over a user-specified time 

range. This report can be run 

against a single group or 

across the entire environment. 

Start Date 

 End Date 

 Group 

Disk Usage 

Report.png 

Inventory  What resources 

were created during 

the given time 

range? 

 What new services 

have been 

discovered? 

(Hyperic auto-

imports services 

and so they are not 

immediately 

obvious.) 

All resources created in the 

Hyperic environment in the 

user-specified time range, 

sorted by creation date. This 

report operates on the entire 

environment. 

Start Date 

 End Date 

Inventory 

Report.png 

https://support.hyperic.com/download/attachments/79660361/Alert+Detail+Report.png?version=1&modificationDate=1326411133260
https://support.hyperic.com/download/attachments/79660361/Alert+Detail+Report.png?version=1&modificationDate=1326411133260
https://support.hyperic.com/display/DOCS50/Hyperic+Glossary#HypericGlossary-priority
https://support.hyperic.com/download/attachments/79660361/Alert+Summary+Report.png?version=1&modificationDate=1326411076374
https://support.hyperic.com/download/attachments/79660361/Alert+Summary+Report.png?version=1&modificationDate=1326411076374
https://support.hyperic.com/download/attachments/79660361/Availability+Downtime+Report.png?version=1&modificationDate=1326411076381
https://support.hyperic.com/download/attachments/79660361/Availability+Downtime+Report.png?version=1&modificationDate=1326411076381
https://support.hyperic.com/download/attachments/79660361/Availability+Downtime+Report.png?version=1&modificationDate=1326411076381
https://support.hyperic.com/download/attachments/79660361/Disk+Usage+Report.png?version=1&modificationDate=1326411367287
https://support.hyperic.com/download/attachments/79660361/Disk+Usage+Report.png?version=1&modificationDate=1326411367287
https://support.hyperic.com/download/attachments/79660361/Inventory+Report.png?version=1&modificationDate=1326411076352
https://support.hyperic.com/download/attachments/79660361/Inventory+Report.png?version=1&modificationDate=1326411076352


49 

Report 

Template 

What Does It Tell 

Me? 

What The Report Displays Required User 

Input 

(Parameters) 

Sample Report 

Event Log 

Summary  

What's happening 

on each of my 

resources? A 

summary of events 

across all 

resources, instead 

of for a single 

resource.  

Resources and their logged 

events, taken from the 

system's event logs, sorted by 

the number of events. 

Start Date 

 End Date 

Event Log 

Summary.png 

License Count The plat forms for 

which I have 

Hyperic licenses. 

Platform name, type, license 

count, and date added. 

No user input License 

Count.png 

Metric Interval  How many metrics 

are being collected 

on my resources, 

how often, and 

when? Basically, 

the report shows 

the metric load.  

The collection interval and the 

number of metrics that are 

being collected for each 

resource.  

No user input Metric Interval 

Report.png 

Network 

Interface 

What kind of traffic 

are my resources 

experiencing? 

Bits in/out per second for each 

resource 

Start Date 

 End Date 

 Group 

Network Interface 

Report.png 

Resources Not 

Collecting 

Metrics 

For which of my 

resources are 

metrics are no 

longer being 

reported, even 

though they're 

supposed to be? 

Resources that have stopped 

publishing metrics, plus the 

last time a metric was 

recorded for the resource 

No user input Resources Not 

Collecting 

Metrics.png 

Resources 

Without Metrics 

Which of my 

resources don't 

have metric 

collection enabled? 

Resources that don't have 

metric collection enabled in 

Hyperic 

No user input Resources 

Without 

Metrics.png 

Unconfigured 

Resources  

Which of my 

resources are not 

configured for 

management? For 

instance, Oracle 

needs a password, 

so when it is 

discovered and 

imported, metrics 

will not be collected 

until the password 

is provided. 

  No user input   

https://support.hyperic.com/download/attachments/79660361/Event+Log+Summary.png?version=1&modificationDate=1326411076360
https://support.hyperic.com/download/attachments/79660361/Event+Log+Summary.png?version=1&modificationDate=1326411076360
https://support.hyperic.com/download/attachments/79660361/License+Count.png?version=1&modificationDate=1326411133246
https://support.hyperic.com/download/attachments/79660361/License+Count.png?version=1&modificationDate=1326411133246
https://support.hyperic.com/download/attachments/79660361/Metric+Interval+Report.png?version=1&modificationDate=1326411133253
https://support.hyperic.com/download/attachments/79660361/Metric+Interval+Report.png?version=1&modificationDate=1326411133253
https://support.hyperic.com/download/attachments/79660361/Network+Interface+Report.png?version=1&modificationDate=1326411133265
https://support.hyperic.com/download/attachments/79660361/Network+Interface+Report.png?version=1&modificationDate=1326411133265
https://support.hyperic.com/download/attachments/79660361/Resources+Not+Collecting+Metrics.png?version=1&modificationDate=1326411133271
https://support.hyperic.com/download/attachments/79660361/Resources+Not+Collecting+Metrics.png?version=1&modificationDate=1326411133271
https://support.hyperic.com/download/attachments/79660361/Resources+Not+Collecting+Metrics.png?version=1&modificationDate=1326411133271
https://support.hyperic.com/download/attachments/79660361/Resources+Without+Metrics.png?version=1&modificationDate=1326411076367
https://support.hyperic.com/download/attachments/79660361/Resources+Without+Metrics.png?version=1&modificationDate=1326411076367
https://support.hyperic.com/download/attachments/79660361/Resources+Without+Metrics.png?version=1&modificationDate=1326411076367
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 For reports involving specific resource types (for example, the Disk Usage and Network Usage 

reports include only "File Server Mount" resources), only compatible groups of that resource 

type are allowed as an input parameter. For all non-resource-type-specific reports (for example, 

the Alert and Availability reports), all groups defined in Hyperic are available for selection.  

Custom Reports 

If you need reports that Hyperic does not provide, you can write your own. Report Center is 

based on JasperReports, and the templates are written in JasperReports' XML format, JRXML. 

To write a report template, Hyperic suggests you use the Java-based application IReport 

(download it). Custom report templates must be in either JRXML format (generated from the 

content created in iReport) or compiled .jasper format. At this time compiled .jasper format is the 

only format supported when deploying new templates to Hyperic. 

For help with JasperReports and iReport, consult their documentation:  

 JasperReports Documentation 

 iReport Documentation 

Requirements for Writing Custom Report Templates 

Because Hyperic's reporting functionality uses JasperReports and only supports reporting 

generation using SQL queries against the Hyperic database, writing custom report templates 

requires familiarity with both JasperReports and the Hyperic database schema. Assistance 

with the creation of custom Reports may be provided by our Professional Services 

Organization. Please contact your sales account representative. 

Running SQL against the production Hyperic database is not recommended, as it may have 

an impact on performance or compromise database integrity. An inefficient or improperly 

configured report query could compromise the database or affect performance. 

The best practice is to run reports in a test environment during development and against a 

replicated production database. 

To incorporate a new report template into Report Center  

1. Write a report template in JRXML or compiled Jasper format, being sure to specify any 

user-input parameters necessary for generating the report (for example, a date range).  

2. Place the template (.jasper format only) in /hq-engine/hq-

server/webapps/ROOT/WEB-INF/reportTemplates. 

3. Log out of Hyperic and log back in, the report will appear in the report list.  

Specifying Report Description and Report Parameters 

In the JasperReport file for a report: 

 Use a <property> element to define a description for the report. The text you specify 

will appear as the Report Description when you select a report on the Report Center 

page 

http://www.jaspersoft.com/JasperSoft_JasperReports.html
http://jasperforge.org/plugins/project/project_home.php?group_id=83
http://jasperforge.org/website/jasperreportswebsite/trunk/documentation.html
http://sourceforge.net/projects/ireport/files/iReport%20%28classic%29/iReport-2.0.2/
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 Use a <parameter> element to specify a report parameter. When you run the report, you 

will be queried to supply the parameter value. The following parameter types are 

supported: 

o java.util.Date 

o java.util.String 
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Views for Specific Resource Types 

This section describes pages in the user interface that are specific to particular resource types 

— these are views enabled by the product plugin that manage the resource type, and are 

present in the Hyperic user interface only if you have resources of that type under management. 

 GemFire View 

 HQ vSphere View 

 tc Server Application Management View 

 Agent Control View 

 Spring Insight View 

GemFire View 

VMware vFabric™ Hyperic®'s GemFire plugin provides a live data user interface for viewing 

metrics in real-time.  (As opposed to the Monitor tab for a GemFire component, which presents 

metrics that have been saved to the Hyperic database.)   

Learn About GemFire Monitoring 

See GemFire in vFabric Hyperic Resource Configuration and Metrics. 

GemFire View for a DS 

The HQ GemFire View for a Distributed System displays the following information.  

 Servers in the DS — The number of Cache Servers, Gateway Hubs and Application 

Peers in the DS. 

 Gateways in the DS — If the DS is part of a multi-site deployment, the number of 

Gateways in the DS's Gateway Hub. 

 Clients connected to the DS — The number of clients (Cache Servers, Gateways, or 

Application Peers) in other Distributed Systems that are connected to the DS. 

The table in the middle of the GemFire View for a DS displays inventory properties and last 

reported metric values for each server (including Cache Servers, Gateway Hubs and Application 

Peers) the DS. 
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GemFire View for a Cache Server or Application Peer 

The GemFire View for a Cache Server or Application Peer displays server and region inventory 

properties and metrics: 

 Server metrics — The single row table presents last reported metric values for the 

Cache Server or Application Peer. 

 Region metrics — The multi-row table presents inventory properties and the Entry Count 

metric for each region the server contains. 

GemFire View for a Gateway Hub 

The HQ GemFire View for a Gateway Hub displays inventory data and live measurements for 

the Gateway Hub, the Hubs and Regions it contains, and any clients connected to the Hub. 

HQ vSphere View 

The HQ vSphere page is an interface for monitoring and managing vSphere Hosts and VMs 

available in vFabric Hyperic. 

See vSphere for information about the management functions supported for each resource type 

and configuration instructions. 

"Performance data not available?" 

The Performance tab appears for a VM only if there is an Hyperic Agent running in the VM. 

Display the HQ vSphere Page 

To display the HQ vSphere page, select HQ vSphere from the Resources tab in the 

Masthead. 

Note: The HQ vSphere option appears on the Resources tab only in vFabric Hyperic, and only 

if you have vSphere components under management. 

You can also navigate to the HQ vSphere page from the Resource Hub. The resource page for 

a vCenter server or vSphere Host has a View in HQ vSphere link above the Monitor tab. 

HQ vSphere and Resource Permissions 

In vFabric Hyperic, a user can only access resources that are assigned to groups to which the 

user's role grants access. The accessible resources are further limited by the role's permissions 

to inventory types. 

In other words, you can see PlatformA in browse dialogs and navigate to it if: (1) it is a member 

of a group assigned to your role, and (2) that role grants access to platforms. 
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The HQ vSphere user interface behaves somewhat differently: if you have view access to 

platforms, you can see all of the vSphere Hosts and vSphere VMs in the deployment whether or 

not they belong to a group assigned to your role. 

Note also that even if your role does not grant view permission to servers, vCenter servers will 

appear in the HQ vSphere page. A vCenter server is the root of the vSphere resource hierarchy 

and is visible regardless of role permissions; the only resource data exposed for the vCenter 

server is its name. 

HQ vSphere Inventory Tab 

The Inventory tab on the HQ vSphere page is a tree of the vSphere resources under HQ 

management, organized in the resource type hierarchy shown below. The lowest level appears 

for a VM that has an Hyperic Agent running and monitoring resources running in the VM.  

The contents of the Inventory tab are updated once per minute. 

You can use the Inventory tab to view the virtual resource hierarchy and to navigate among 

resources. When you select a resource, the tab or tabs on the right side of the page contain 

resource data, performance charts, and resource control commands, as appropriate to the 

resource type. 

The table below shows the vSphere resource type hierarchy; the right column indicates the 

inventory level for a type in the Hyperic inventory model.    

Vsphere Resource Hierarchy Inventory Type 

VMware vCenter server 

    VMware vSphere Host platform 

         VMware vSphere VM platform 

              Hyperic Agent-managed resource in VM        server 

The screenshot shows an expanded hierarchy in the Inventory tab. 
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Icons in the vSphere Inventory Tab 

The icon to the left of an item in the resource tree indicates the type of the resource, and for 

a VM, its availability status. For information about how VM availability is determined, see 

VMware vSphere VM Metrics below. 

 vCenter Server 

 vSphere Host 

 VM whose availability is Up 

 VM whose availability is Paused 

 VM whose availability is Powered Off 

 VM whose availability status is Down 

 VM whose availability status is Unknown 

 A Hyperic-managed resource running in a VM that has an Hyperic Agent 

running in it. 
 

HQ vSphere Summary Tab 

The Summary tab, available when any resource in the Inventory tab is selected, displays 

properties for the selected resource, and its parent resource, as applicable.  

Jump to Resource Hub View of a Resource 

To view a vSphere resource in the Hyperic resource hub — for instance to visit its Inventory 

or Alert page — click the view resource link to the right of the resource name. 

Summary Tab for vCenter 

When a vCenter Server instance is selected in the HQ vSphere page, the Summary tab 

contains the name of the vCenter instance. You can view inventory and configuration properties 

for the vCenter instance in the Resource Hub — click view resource next to the resource name 

to view it in the Resource Hub. 

Summary Tab for vSphere Hosts 

The Summary tab for a vSphere Host displays the following properties: 

 Host Information 

o Hostname 

o Location 

o Manufacturer 

o Model 

o VMware Version 

 Processor Details 

o Type - of the processor 
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o CPUs - Processor sockets and cores per socket 

 Network Details  

o IP Address 

o Default Gateway 

o DNS - primary and secondary DNS server 

Summary Tab for vSphere VM 

The Summary tab for a vSphere VM displays the following VM properties: 

 VM Information 

o Hostname - of the vSphere Host (ESX platform) where the VM runs 

o Guest OS - operating system running in the VM 

o vCPU(s) - number of virtual processors in the VM 

o Memory - VM memory, in MB 

o MAC Address 

o IP - VM's IP address 

o VM Version - virtual machine hardware version 

o Tools Version - version of VMware Tools on the VM. 

o Config Details 

 ESX Host - IP address of the vSphere Host (ESX platform) where the VM 

runs 

 Resource Pool - resource pool with which the VM is associated 

 Config File - path to the the VM configuration (.vmx) file, expressed using the 

symbolic link path to the VMFS volume where the file is stored 

Properties for the vSphere Host where the VM runs, described above in Summary Tab for 

vSphere Hosts, are shown below the VM properties. 

If the VM does not have an Hyperic Agent running in it, the Summary tab has a "Performance 

data not available" near the top of the page. 

Summary Tab for a Managed Resource in the VM 

Note: This information applies to a VM with a running Hyperic Agent that is managing resources 

in the VM. Otherwise, resources running in the VM do not appear in the HQ vSphere page. 

When you select a managed resource running in a VM, the Summary tab displays the vSphere 

Host and VM properties described in Summary Tab for vSphere VM. 

The contents of the Summary tab are updated once per minute. 

To view inventory properties for the managed resource itself, click the view resource link next 

to the resource name to view the resource in the Resource Hub. 
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HQ vSphere Performance Tab 

The Performance tab appears when a vSphere Host is selected, and, if the VMs running on the 

host have Hyperic Agents running, for each VM, and for the managed resources running in the 

VMs. 

The contents of the Performance tab are updated once per minute. 

If a VM does not have an agent running in it, no Performance tab appears. You can view 

the VM metrics in its Monitor page in the Resource Hub. Click view resource next to the 

"Hostname" property on the VM's Summary tab. 

View Metrics 

The Performance tab displays an Availability bar, and a chart for each metric currently 

enabled for the selected resource type. 

The tables in VMware vSphere Host Metrics and VMware vSphere Host Metrics list supported 

vSphere metrics and default settings. 

Twelve hours history is displayed by default. You can use the Data Range pull-down to set the 

display range to the most recent: 

 1, 4, or 12 hours 

 1 or 2 days, 

 1 week, or 

 1 month 

Correlate Metrics 

On the Performance tab for a VM or an Hyperic Agent-managed resource running in the VM, 

you can use the Compare pull-down to correlate the selected resource's performance with its 

parent or grandparent. You can: 

 Compare each VM metric with its vSphere Host equivalent — For example compare 

the VM's "Disk Usage (Average)" metric to its host's "Disk Usage (Average)" metric; the 

VM's "CPU Usage (Average)" metric to its host's "CPU Usage (Average)" metric; and so 

on. 

 Compare each VM metric to a selected vSphere Host metric — For example, 

compare each VM metric to the "Disk Usage (Average)" metric of its vSphere host.  

 Compare metrics for a managed resource in the VM with performance of the VM or 

the vSphere host — Use the Compare pull-down to select a VM or Host metric - the 

charts for the managed resource metrics will be overlayed with the line for the selected 

VM or host metric. The screen shot is an example in which the vSphere Hosts's "CPU 

Usage (Average)" counter is overlayed on each Hyperic Agent metric chart. 
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HQ vSphere Control Tab 

The Control tab appears when a VM is selected (if there is an Hyperic Agent running in the VM) 

and allows you to issue a control command to the VM. See Management Functions for VMware 

VSphere VM for information about the supported control actions. 

If a VM does not have an agent running in it, no Control tab appears. You can run control 

actions from the "Control" page for the VM in the Resource Hub. Click view resource next to 

the "Hostname" property on the VM's Summary tab. 

Metrics 

VMware vSphere Host Metrics 

Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

Availabil  

ity 

Availabil  

ity 

n/a, 

Availability is 

determined 

by HQ; it is 

not a 

vCenter 

statistic. 

The plugin determines a 

vSphere Host's availability by 

querying vCenter for the host's 

power state, once per minute, 

by default. Availability takes 

these values:If the power state 

is: 

 Up — if vSphere Host 

power state is 

poweredOn. 

 Paused — if vSphere Host 

power state is standby. 

 Powered Off — if 

vSphere Host power state 

is poweredOff. 

 Down — if the vSphere 

Host power state is none 

of the above.  

percent Availabil  

ity 

true 1 min 

Uptime sys.upti

me.lates

t 

    sec Availabil  

ity 

false 1 min 
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Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

CPU 

Usage 

(Averag

e) 

cpu.usa

ge.avera

ge 

1 CPU usage as a percentage 

during the interval.  

Actively used CPU of the host, 

as a percentage of the total 

available CPU. Active CPU is 

approximately equal to the 

ratio of the used CPU to the 

available CPU. 

available CPU = # of physical 

CPUs × clock rate 

100% represents all CPUs on 

the host. For example, if a 

four-CPU host is running a 

virtual machine with two CPUs, 

and the usage is 50%, the host 

is using two CPUs completely. 

percent Utilization true 5 min 

Disk 

Usage 

(Averag

e) 

disk.usa

ge.avera

ge 

1 Aggregated disk I/O rate. For a 

vSphere host, this includes the 

rates for all virtual machines 

running on the host during the 

collection interval.  

KB per 

second 

Utilization true 5 min 

Highest 

Disk 

Latency  

disk.max

TotalLat

ency.late

st 

1 Highest latency value across 

all disks used by the host. 

Latency measures the time 

taken to process a SCSI 

command issued by the guest 

OS to the virtual machine. The 

kernel latency is the time 

VMkernel takes to process an 

IO request. The device latency 

is the time it takes the 

hardware to handle the 

request. 

Total latency = kernelLatency 

+ deviceLatency  

ms Utilization true 5 min 

Memory 

Usage 

(Averag

e) 

mem.us

age.aver

age 

1 memory usage = memory 

consumed ÷ host configured 

memory size 

percent Utilization true 5 min 
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Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

Network 

Usage 

(Averag

e) 

net.usag

e.averag

e 

1 Sum of the data transmitted 

and received during the 

collection interval.Sum of data 

transmitted and received 

across all physical NIC 

instances connected to the 

host. 

KB Utilization true 5 min 

CPU 

Reserve

d 

Capacity 

cpu.rese

rvedCap

acity.ave

rage 

2 Total CPU capacity reserved 

by the virtual machines. 

none Utilization false 5 min 

CPU 

Throttled 

(1 min. 

Average

) 

rescpu.

maxLimit

ed1.late

st 

3   percent Utilization false 5 min 

CPU 

Throttled 

(5 min. 

Average

) 

rescpu.

maxLimit

ed5.late

st 

3   percent Utilization false 5 min 

CPU 

Throttled 

(15 min. 

Average

) 

rescpu.

maxLimit

ed15.lat

est 

3   percent Utilization false 5 min 

CPU 

Running 

(1 min. 

Average

) 

rescpu.r

unav1.la

test 

3   percent Utilization false 5 min 

CPU 

Running 

(5 min. 

Average

) 

rescpu.r

unav5.la

test 

3   percent Utilization false 5 min 

CPU 

Running 

(15 min. 

Average

) 

rescpu.r

unav15.l

atest 

3   percent Utilization false 5 min 
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Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

CPU 

Active (1 

min. 

Average

) 

rescpu.a

ctav1.lat

est 

3   percent Utilization false 5 min 

CPU 

Active (5 

min. 

Average

) 

rescpu.a

ctav5.lat

est 

3   percent Utilization false 5 min 

CPU 

Active 

(15 min. 

Average

) 

rescpu.a

ctav15.la

test 

3   percent Utilization false 5 min 

Memory 

Swap In 

mem.sw

apin.ave

rage 

2 Sum of memory swapin of all 

powered on VMs on the host.  

KB Utilization false 5 min 

Memory 

Swap 

Out  

mem.sw

apout.av

erage 

2 Sum of Memory Swap Out of 

all powered on VMs on the 

host. 

KB Utilization false 5 min 

Memory 

Swap 

Used 

mem.sw

apused.

average 

2 Amount of memory that is 

used by swap. Sum of Memory 

Swapped of all powered on 

virtual machines and vSphere 

services on the host. 

KB Utilization false 5 min 

Memory 

Balloon 

mem.vm

memctl.

average 

1 Sum of Memory Balloon 

(Amount of memory allocated 

by the virtual machine memory 

control driver) of all powered 

on virtual machines and 

vSphere services on the host. 

If the balloon target value is 

greater than the balloon value, 

the VMkernel inflates the 

balloon, causing more virtual 

machine memory to be 

reclaimed. If the balloon target 

value is less than the balloon 

value, the VMkernel deflate the 

balloon, which allows the 

virtual machine to consume 

additional memory if needed. 

KB Utilization true 5 min 
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Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

Memory 

Unreser

ved 

mem.unr

eserved.

average 

2 Amount of memory that is 

unreserved. Memory 

reservation not used by the 

Service Console, VMkernel, 

vSphere services and other 

powered on VMs' user-

specified memory reservations 

and overhead memory. 

KB Utilization false 5 min 

Memory 

Heap 

mem.he

ap.avera

ge 

2 Amount of VMkernel virtual 

address space dedicated to 

VMkernel main heap and 

related data.  

KB Utilization false 5 min 

Memory 

Heap 

Free 

mem.he

apfree.a

verage 

2 Amount of free address space 

in the VMkernel's main heap. 

Heap Free varies, depending 

on the number of physical 

devices and various 

configuration options. There is 

no direct way for the user to 

increase or decrease this 

statistic. 

KB Utilization false 5 min 

Memory 

Overhea

d 

mem.ov

erhead.a

verage 

1 Total of all overhead metrics 

(Amount of additional machine 

memory allocated to a virtual 

machine for overhead. The 

overhead amount is beyond 

the reserved amount).for 

powered-on virtual machines, 

plus the overhead of running 

vSphere services on the host. 

KB Utilization false 5 min 

Memory 

Zero 

mem.zer

o.averag

e 

2 Amount of memory that is 

zeroed out (contains only 0s). 

This statistic is included in 

Memory Shared.  For a 

vSphere Host, Sum of Memory 

Zero of all powered on VMs 

and vSphere services on the 

host. 

KB Utilization false 5 min 

Memory 

Reserve

d 

Capacity 

mem.res

ervedCa

pacity.av

erage 

2 Total amount of memory 

reservation used by powered 

on VMs and vSphere services 

on the host. Includes overhead 

amount. 

MB Utilization false 5 min 
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Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

Memory 

Active 

mem.act

ive.aver

age 

2 Amount of memory actively 

used, as estimated by 

VMkernel. Active memory is 

based on the current workload 

of the virtual machine or host. 

For a vSphere Host, sum of 

the active guest physical 

memory of all powered on 

virtual machines on the host, 

plus memory used by basic 

VMKernel applications on the 

host. 

KB Utilization true 5 min 

Memory 

Shared 

mem.sh

ared.ave

rage 

2 Sum of the shared memory 

values of all powered-on virtual 

machines, plus the amount for 

the vSphere services on the 

host. The host's Memory 

Shared may be larger than the 

amount of machine memory if 

memory is overcommitted (the 

aggregate virtual machine 

configured memory is much 

greater than machine 

memory). The value of this 

statistic reflects how effective 

transparent page sharing and 

memory overcommitment are 

for saving machine memory.  

KB Utilization true 5 min 

Memory 

Granted 

mem.gra

nted.ave

rage 

2 The total of all granted metrics 

for all powered-on virtual 

machines, plus memory for 

vSphere services on the host. 

KB Utilization false 5 min 

Memory 

Consum

ed 

mem.co

nsumed.

average 

1 Amount of machine memory 

used on the host. Consumed 

memory includes memory 

used by virtual machines, the 

service console, VMkernel, 

and vSphere services, plus the 

total consumed memory for all 

running virtual machines. 

host consumed memory = total 

host memory - free host 

memory 

KB Utilization false 5 min 
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Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

Memory 

State 

mem.sta

te.latest 

2 Amount of free machine 

memory on the host. VMkernel 

has four free-memory 

thresholds that affect the 

mechanisms used for memory 

reclamation.  

0 (High) - Free memory >= 6% 

of machine memory - service 

console memory  

1 (Soft) - Free memory >= 4% 

of machine memory - service 

console memory  

2 (Hard) - Free memory >= 2% 

of machine memory - service 

console memory  

3 (Low)- Free memory >= 1% 

of machine memory - service 

console memory  

For 0 and 1, swapping is 

favored over ballooning. 

For 2 and 3, ballooning is 

favored over swapping.  

none Utilization false 5 min 

Memory 

Shared 

Commo

n 

mem.sh

aredcom

mon.ave

rage 

2 Amount of machine memory 

that is shared by all powered-

on virtual machines and 

vSphere services on the host. 

Memory Shared - Memory 

Shared Common = Host 

memory saved by sharing 

KB Utilization false 5 min 

Memory 

Used by 

vmkerne

l 

mem.sys

Usage.a

verage 

2 Amount of memory used by 

the VMkernel. Amount of 

machine memory used by the 

VMkernel for "core" 

functionality (such as its own 

internal uses, device drivers, 

etc). It does not include 

memory used by VMs or by 

vSphere services. 

KB Utilization false 5 min 
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VMware vSphere VM Metrics 

Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

Availabil  

ity 

Availabil  

ity 

n/a, 

Availability is 

determined 

by HQ; it is 

not a 

vCenter 

statistic. 

The plugin determines a VM's 

availability by querying 

vCenter for a VM power state, 

once per minute, by default. 

Availability takes these 

values:If the power state is: 

 Up — if VM power state is 

poweredOn. 

 Paused — if VM power 

state is standby. 

 Powered Off — if VM 

power state is 

poweredOff. 

 Unknown — if the VM 

power state is none of the 

above.  

 Down — if VM availability 

was not reported for a 

duration equal to, or greater 

than, twice the configured 

collection interval, which is 

1 minute, by default. 

percente Availabil  

ity 

true 1 min 

Uptime sys.upti

me.latest 

1   sec Availabil  

ity 

false 1 min 

CPU 

Usage 

(Averag

e) 

cpu.usag

e.averag

e 

1 CPU usage as a percentage 

during the interval.  

 

This value is reported with 

100% representing all 

processor cores on the 

system. As an example, a 2-

way VM using 50% of a four-

core system is completely 

using two cores. 

percent Utilization true 5 min 

Disk 

Usage 

(Averag

e) 

disk.usa

ge.avera

ge 

1 Aggregated disk I/O rate. KB per 

second 

Utilization true 5 min 

Memory 

Usage 

(Averag

e) 

mem.usa

ge.avera

ge 

1 The percentage of memory 

used as a percent of all 

available machine memory. 

percent Utilization true 5 min 
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Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

Network 

Usage 

(Averag

e) 

net.usag

e.averag

e 

1 Sum of the data transmitted 

and received during the 

collection interval.  

KB Utilization true 5 min 

CPU 

Throttle

d (1 min. 

Average

) 

rescpu.m

axLimite

d1.latest 

3   percent Utilization false 5 min 

CPU 

Throttle

d (5 min. 

Average

) 

rescpu.m

axLimite

d5.latest 

3   percent Utilization false 5 min 

CPU 

Throttle

d (15 

min. 

Average

) 

rescpu.m

axLimite

d15.lates

t 

3   percent Utilization false 5 min 

CPU 

Running 

(1 min. 

Average

) 

rescpu.ru

nav1.late

st 

3   percent Utilization false 5 min 

CPU 

Running 

(5 min. 

Average

) 

rescpu.ru

nav5.late

st 

3   percent Utilization false 5 min 

CPU 

Running 

(15 min. 

Average

) 

rescpu.ru

nav15.lat

est 

3   percent Utilization false 5 min 

CPU 

Active (1 

min. 

Average

) 

rescpu.a

ctav1.lat

est 

3   percent Utilization false 5 min 
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Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

CPU 

Active (5 

min. 

Average

) 

rescpu.a

ctav5.lat

est 

3   percent Utilization false 5 min 

CPU 

Active 

(15 min. 

Average

) 

rescpu.a

ctav15.la

test 

3   percent Utilization false 5 min 

Memory 

Swap In 

mem.sw

apin.aver

age 

2 Average memory Swap In. A 

large number here represents 

a problem with lack of memory 

and a clear indication that 

performance is suffering as a 

result. 

KB Utilization false 5 min 

Memory 

Swap 

Out  

mem.sw

apout.av

erage 

2 Average Memory Swap Out. A 

large number here represents 

a problem with lack of memory 

and a clear indication that 

performance is suffering as a 

result. 

KB Utilization false 5 min 

Memory 

Balloon 

mem.vm

memctl.a

verage 

1 Sum of Memory Balloon 

(Amount of memory allocated 

by the virtual machine memory 

control driver) 

 

If the balloon target value is 

greater than the balloon value, 

the VMkernel inflates the 

balloon, causing more virtual 

machine memory to be 

reclaimed. If the balloon target 

value is less than the balloon 

value, the VMkernel deflate the 

balloon, which allows the 

virtual machine to consume 

additional memory if needed. 

KB Utilization true 5 min 

Memory 

Balloon 

Target  

mem.vm

memctlta

rget.aver

age 

2   KB Utilization false 5 min 
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Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

Memory 

Zero 

mem.zer

o.averag

e 

2 Amount of memory that is 

zeroed out (contains only 0s). 

This statistic is included in 

Memory Shared.  

 

For a vSphere Host, Sum of 

Memory Zero of all powered 

on VMs and vSphere services 

on the host. 

KB Utilization false 5 min 

Memory 

Active 

mem.acti

ve.avera

ge 

2 Amount of memory actively 

used, as estimated by 

VMkernel. Active memory is 

based on the current workload 

of the virtual machine or host. 

 

For a vSphere Host, sum of 

the active guest physical 

memory of all powered on 

virtual machines on the host, 

plus memory used by basic 

VMKernel applications on the 

host. 

KB Utilization true 5 min 

Memory 

Shared 

mem.sha

red.aver

age 

2 The average amount of shared 

memory. Shared memory 

represents the entire pool of 

memory from which sharing 

savings are possible. The 

amount of memory that this 

has been condensed to is 

reported in shared common 

memory. So, total saving due 

to memory sharing equals 

shared memory minus shared 

common memory.  

KB Utilization true 5 min 

Memory 

Granted 

mem.gra

nted.aver

age 

2 The amount of memory that 

was granted to the VM by the 

host. Memory is not granted to 

the host until it is touched one 

time and granted memory may 

be swapped out or ballooned 

away if the VMkernel needs 

the memory. 

KB Utilization false 5 min 
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Name Alias vCenter 

Statistics 

Level 

Definition Units Category Default 

On 

Default 

Interval 

Memory 

Consum

ed 

mem.con

sumed.a

verage 

1 The amount of machine 

memory that is in use by the 

VM. 

 

While a VM may have been 

configured to use 4 GB of 

RAM, as an example, it might 

have 

only touched half of that. Of 

the 2 GB left, half of that might 

be 

saved from memory sharing. 

That would result in 1 GB of 

consumed memory. 

KB Utilization false 5 min 

tc Server Application Management View 

This page is present in the Hyperic user interface only if have the plugin.  

tc Runtime Application Management 

The Application Management page, available when a tc Runtime instance or a group of tc 

Runtime instances is selected, enables an authorized user to manage applications deployed 

that server instance or group. 

The HQ super-user can use all the tc Runtime Application Management features of the HQ UI.  

If,  however, you log on to the HQ UI as a non-super-user, then that user  must have certain 

permissions to be able to use the tc Runtime features.  See User Permissions Required to Use 

the tc Runtime Features for details. 

An HQ Group is not a Cluster 

An HQ group is not equivalent or similar to a tc Runtime cluster. 

 An HQ group is a set of other managed resources. An authorized user can create a 

group and assign resources to it. A group whose members are all of the same 

resource type is referred to as a compatible group. You can manage and monitor the 

resources in a compatible group at the group level. Grouping tc Runtime instances 

allows you manage applications across multiple tc Runtime instances. 

 A tc Runtime cluster enables session replication. Clustering behavior is defined in a 

tc Runtime instance's server.xml file. 
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Navigating to a tc Runtime Instance Or Group 

To navigate to the Application Management page of a tc Runtime instance or group.  

1. Click Resources > Browse at the top of the HQ Dashboard. 

a. To browse to a server instance click Servers to view a list of the servers to which 

you have access.  tc Runtime instances have the server type "SpringSource tc 

Runtime 6.0". Apache Tomcat server instances have the server type "Tomcat X.X".  

b. To browse to a group of servers click Compatible Groups/Clusters to view a list all 

the compatible groups to which you have access. Groups of tc Runtime have the 

type "SpringSource tc Runtime 6.0". 

2. In the table, click the name of the tc Runtime instance or group to which you want to 

navigate. 

3. Click Views > Application Management. 

Creating tc Runtime Groups 

Grouping tc Runtime instances eases the process of managing server instances and 

applications. For example, you can deploy an application to group of tc Runtime with a single 

command, instead of deploying to each instance individually. To create a group of tc Runtime 

instances: 

1. Click Resources > Browse at the top of the HQ Dashboard. 

2. Click Servers to list servers in inventory to which you have access. (Note: Only server 

instances that have been auto-discovered by HQ and added to inventory appear). tc 

Runtime instances have the server type "SpringSource tc Runtime 6.0". Apache Tomcat 

server instances have the server type "Tomcat X.X". 

3. Check the box to the left of each tc Runtime instance you want to include in the new 

group. 

4. Click Group. 

5. Enter a name for the group (required) and a description and location as desired.  

1. Click OK. 

Listing Applications 

Navigate to the Application Management page for a server instance or group. Deployed 

applications are listed in the Deployed Applications section of the page. For a group, the table 

lists all applications deployed to all servers in the group. The table shows: 

 Status — The state of the application - either "Running" or "Stopped".  For a group of 

servers: 

o "Running" or "Stopped" indicates that all instances of the application on all servers 

in the group have that state. 

o A numeric value indicates the number of servers upon which the application's state 

is "Running". 

 Sessions — The number of current active sessions for the application. 

 Revision — Current revision of the application. Hyperic creates a new revision each 

time you deploy an application that uses an existing context path 



71 

NOTE: Only applications on running tc Runtime instances appear.  HQ returns an error for 

application hosts that are not running. 

Deploying Applications 

Deploying an application is the process of uploading it to tc Runtime and making it available to 

users. You can deploy an application to a single tc Runtime instance or to a group of tc Runtime 

instances. If you deploy to a group, the application will be deployed to each of tc Runtime 

instance in that group, enabling users to run the application from any of the tc Runtime 

instances in the group. 

You can deploy an application from a WAR file located: 

 on your local file system (on the the same machine as the browser you are using to 

connect to HQ's web user interface), or  

 on the computer on which the tc Runtime resource is running. 

Whether the WAR file is local or remote, you can either enter a new context path (string that 

uniquely identifies the Web application in the URL used to invoke it), or use the default value, 

which is the name of the WAR file, without the".war" extension. 

1. Navigate to the Application Management page for a tc Runtime instance or group. 

2. Depending on the location of the WAR file for the application, either:  

o Click Browse in the Deploy Application From Local Machine section to browse 

to the file's location. 

o Enter the full path to the WAR file on the computer hosting the tc Runtime resource 

in the Deploy Application from Server Machine section. 

3. As desired, enter a context path in the Context path text box. 

4. Optionally check the Use cold deployment strategy if you want the  tc Runtime 

instance to shutdown, deploy the  application, and then  start up again. By default (if box 

is unchecked),  the tc Runtime  instance hot-deploys the application, which means it 

does  not shutdown  then restart but simply deploys the application while the  instance is  

still running. Use the cold deployment strategy if you want  to avoid  common hot 

deployment errors, such as running out of PermGen  space. The  PermGen space holds 

the metadata about classes that have been   loaded/created in the JVM. 

5. Click Upload and Deploy or Deploy, whichever is appropriate. 

6. See the top "Results of the last operation" section for details about the result of 

deploying the application. When you deploy an application to tc Runtime, the application 

is started. 

Undeploying Applications 

Undeploying an application removes it from the tc Runtime instance or group. If you want to 

temporarily prevent users from access an application, stop it rather than undeploy it. See 

Stopping Applications. 
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1. Navigate to the application management page of a tc Runtime instance or group.  

2. In the Deployed Applications section, check the box to the far-left of the application(s) 

you want to undeploy. 

3. Click Undeploy. HQ removes the application from the list of deployed applications. 

4. See the top "Results of the last operation" section for details about the results of 

undeploying the application. 

Starting Applications 

Starting an application makes it available to users. You must have previously deployed the 

application to be able to start it. 

1. Navigate to the application management page of a tc Runtime instance or group.  

2. In the Deployed Applications section, check the box to the far-left of the application(s) 

you want to start. 

3. Click Start. The status of the application changes to "Running".  

4. See the top "Results of the last operation" section for details about the result of starting 

the application. 

Stopping Applications 

Stopping an application makes it unavailable to users. 

1. Navigate to the application management page of a tc Runtime instance or group.  

2. In the Deployed Applications section, check the box to the far-left of the application(s) 

you want to stop. 

3. Click Stop. The status of the application changes to "Stopped". 

4. See the top "Results of the last operation" section for details about the result of stopping 

the application. 

Reloading Applications 

When you reload an existing application, it shuts itself down and then reloads itself. For 

additional details, see Reload an Existing Application on the Apache Tomcat 6.0 Web site. 

1. Navigate to the application management page of a tc Runtime instance or group.  

2. In the Deployed Applications section, check the box to the far-left of the application(s) 

you want to reload. 

3. Click Reload. The status of the application changes to "Running." 

4. See the top "Results of the last operation" section for details about the result of reloading 

the application. 

Agent Control View 

You can run Hyperic Agent control commands — for a single agent, or for a group of agents — 

from the Hyperic user interface. 

http://tomcat.apache.org/tomcat-6.0-doc/manager-howto.html#Reload+An+Existing+Application
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Restart an Agent or a Group of Agents 

1. Navigate to the Hyperic Agent or group of agents. 

2. Click the Views tab. 

3. Click Agent Commands. 

4. Select the restart command. 

5. Click Execute. 

This command invokes the agent's Java Service Wrapper's *restart *command, which 

shuts down the JVM process in which the agent runs, waits for the process to terminate 

cleanly, and spawns a new JVM process for the agent. During the restart process, the 

agent's metric collection and resource control functionality will be interrupted. 

The restart command happens asynchronously. To verify successful restart, navigate to 

the agent in the Hyperic user interface check its availability. .  

Ping an Agent or a Group of Agents 

1. Navigate to the Hyperic Agent or group of agents. 

2. Click the Views tab. 

3. Click Agent Commands. 

4. Select the ping command. 

5. Click Execute. 

 This command invokes the agent's Java Service Wrapper's ping command on the 

agent. 

 If the ping is not successful, this message appears in the Result pane on the right side 

of the page: 

Failed to send ping command to agent with id nnnnn. Reason: 

Unable to connect to AgentIpAddress. 

 If the ping is successful, this message appears in the Result pane on the right side of 

the page: 

Successfully sent ping command to agent with id nnnnn. 

Upgrade an Agent or Group of Agents to a Newer Version 

1. Navigate to the Hyperic Agent or group of agents. 

2. Click the Views tab. 

3. Click Agent Commands. 

4. Select the upgrade command. 

5. Select a bundle from the agent bundle pull-down list. 

6. Click Execute. 

 The selected agent bundle is transferred from the Hyperic Server to the target agent(s). 

 The agent expands the bundle locally. 

 The agent updates the local bundle property. 

 The server restarts the agent. 

 The configuration settings in the agent.properties file are preserved. 
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Push a Plugin to an Agent or Group of Agents 

This operation allows you to transfer new, custom, updated, or patched plugins from the Hyperic 

Server's ServerHome/hq-engine/hq-server/webapps/ROOT/WEB-INF/hq-plugins 

directory to the target agents' AgentHome/bundles/AgentBuildDir/pdk/plugins 

directory. Pushing a plugin to an agent results in an agent restart. 

1. Navigate to the Hyperic Agent or group of agents. 

2. Click the Views tab. 

3. Click Agent Commands. 

4. Select the push plugin command. 

5. Select a plugin from the plugin pull-down list. 

6. Click Execute. 

Spring Insight View 

Spring Insight Applications 

This page describes the Spring Insight Applications page, available if you have Insight 

Operations under management. 

Understanding Application Metrics 

The Spring Insight Applications page presents multiple metrics that indicate how well an 

application is running, for instance, the percentage of application requests had an unacceptable 

response time, how many requests return errors, and so on. 

These metrics, described in the sections below, appear in several places in the Spring Insight 

Applications user interface: on the Health tab, which presents metrics for all applications 

reporting to Hyperic monitored Dashboards applications, and also on the Performance tab for 

an Insight Dashboard or an Insight Application. 

Application Health 

The Application Health metric for an application is the health value that Insight calculates for the 

application. The Insight health metric is based on the percentage of Insight traces that complete 

without error. The values, indicators, and thresholds for the Application Health metric are 

defined below. 
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Value Indicator Percentage of Successful Insight Traces 

Excellent  
 

94% or more 

Good  
 

85% - 93% 

Fair  
 

70% - 84% 

Poor  
 

50% - 83% 

Unacceptable  
 

0% - 49% 

Application Vitals 

The Vitals metric for an application is calculated by Hyperic. It is based on the Application 

Health metric (described above), and also takes into account the Hyperic metrics and events for 

the application and for resources that the application depends upon, including:  

 Number of unfixed alerts for the application in Hyperic. 

 Availability of the managed resources that the application depends upon:  application 

servers, database servers (if applicable), and platforms. 

 Number of unfixed alerts for the resources that the application depends upon:  

application servers, database servers (if applicable), and platforms. 

If an application has no unfixed alerts in Hyperic and the resources it depends upon are 

available and have no unfixed alerts, the application's value of the applications Vitals metric is 

equal to the value of its Application Health metric. 

Unfixed Alert Count 

The number of unfixed alerts during the timeframe. 

Error Rate 

The percentage of Insight traces that resulted in an HTTP error status code (500 to 600).  

Response Time Levels 

The "Invocations" metric tells you what percentage of traces had response times in each of 

three response time levels. The response time thresholds for each level are configurable in 

Spring Insight, and by default are: 

 Satisfied — Response time 200 ms or less. 

 Tolerated — Response time over 200 ms but less than 800 ms. 

 Frustrated — Response time 800 ms or over. 
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For example 

19.8%/7.4%/72.7%  

indicates that over the selected interval: 

 19.2% of the traces had response time 200 ms or less. 

 7.5% had response time over 200 ms but less than 800 ms. 

 73.4% had response time 800 ms or over. 

Contents of the Spring Insight Applications Page 

The sections below describe the contents of each section of the Spring Insight Applications 

page. 

Dashboards Tab 

The Dashboards pane on the left side of the Spring Insight Applications page is a tree 

control whose nodes are Insight Dashboards and Insight Applications.  

The color of the bar to the left of a Dashboard node indicates the worst Vitals metric among the 

applications reporting to the Dashboard. 

You use the Dashboards pane to browse a hierarchy of performance data. Depending on your 

need and interest, you view filter your view to include health information for:  

 All applications reporting to all Hyperic-managed Insight Dashboards 

This is the view that appears when neither a dashboard or application is selected in the 

tree control. To return to this view, click the Dashboards link above the tree control. For 

a description of the view, see Health Tab for all Applications. 

 Just the applications reporting to a particular Insight Dashboards 

To display this view, click the dashboard of interest in the tree control. For a description 

of the view, see  Performance Tab for a Dashboard. 

 Just one particular application 

To display this view, select the application of interest in the tree control. For a description 

of the view, see Performance Tab for an Application. 

Health Tab for all Applications 

The Health tab summarizes the health of all of the applications reporting to Hyperic-managed 

Insight Dashboards. This tab is present when you first open the Spring Insight Applications 

page. 

After navigating to a dashboard or an application, you can redisplay the Health tab by clicking 

the "Dashboards" link at the top of the left pane. 
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The Health tab contains the following data and metrics: 

 Applications Health Trend chart — By default, this chart plots the health of the five 

applications that currently have the poorest vitals. You can add and remove applications 

to the chart by checking and unchecking the box next to it. For a definition of the metric, 

see Application Health. 

 Worst Vitals  — The Vitals indicator in the "All Applications" bar reflects the worst value 

reported among all applications reporting to all Dashboards. For a definition of the Vitals 

metric, see Application Vitals. 

 Application Metrics — Below the Applications Health Trend chart is a list of all 

applications under management, ordered by the applications' Vitals metric, starting with 

the worst. The following data and metrics are displayed for each application:  

o Application — The name of the application is a link; if you click it, the Performance 

tab for the dashboard appears. See Performance Tab for an Application. 

o Vitals 

o Alerts — For a definition of the metric, see Unfixed Alert Count. 

o Errors — For a definition of the metric, see Error Rate. 

o Invocations (F/T/S) — For a definition of the metric, see Response Time Levels. 

Performance Tab for a Dashboard 

To display the Performance tab for an Insight Dashboard, click the dashboard's name in the 

Dashboards tab. 

Note: In the list of applications reporting to the dashboard: 

 The list is ordered by application health, from worst to best. 

 You can mouse over the application name to highlight the line for it in the Application 

Health Trend chart. 

 You can click the application name to display the Performance tab for it. See 

Performance Tab for an Application. 

The Performance tab for a Dashboard contains: 

 Applications Health Trend chart — By default, this chart plots the health of the five 

applications (reporting to the Dashboard) that currently have the poorest vitals. You can 

add and remove applications to the chart by checking and unchecking the box next to it. 

For a definition of the metric, see Application Health. 

 Dashboard Vitals  — The Vitals indicator in the "Dashboard" bar is a composite health 

indicator that takes into account: 

o The Vitals for the applications reporting to the currently selected Insight Dashboard. 

o Availability of the managed resources that the Insight Dashboard depends upon: 

application server (tc Server) and platform. 

o Number of unfixed alerts for the resources that the Insight Dashboard depends 

upon: application server (tc Server) and platform. 
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 Application Metrics — Below the Applications Health Trend chart is a list of the 

applications reporting to the Dashboard. The following metrics are displayed for each 

application: 

o Vitals — For a definition, see Application Vitals. 

o Alerts — For a definition, see Unfixed Alert Count. 

o Errors — For a definition, see Error Rate. 

o Invocations (F/T/S) — For a definition, see Response Time Levels. 

 Application Server Performance — To view health data for the application server that the 

Insight Dashboard runs on,  click the control in the Application Server bar. See 

Application Server Performance. 

 Platform Performance — To view health data for platform on which the Insight 

Dashboard runs, click the control in the Platforms bar.  See Platform Performance. 

Application Server Performance 

The "Application Server" section charts a selected app server metric for all, or selected 

application servers where the applications in the dashbaord run.  

The Metric Low/Avg/Peak pulldown lists all of the available metrics for the application server 

and shows the low, average, and peak values for the metric over the current time range.  

Choose a metric from the list to graph it. 

Below the chart, the following information is listed for each application server:  

 name — The name of the resource in Hyperic. 

 AVAIL — Current availability of the resource 

 ALERTS — Current number of unfixed alerts 

 LOW — Low value during current display range. 

 AVG — Average value during current display range. 

 PEAK — High value during current display range. 
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Platform Performance 

The "Platform" section charts a selected platform metric for all, or selected platforms where the 

applications in the dashboard run. 

 

The Metric Low/Avg/Peak pulldown lists all of the available platform metrics and shows the 

low, average, and peak values for the metric over the current time range. Choose a metric from 

the list to graph it. 

Below the chart, the following information is listed for each platform: 

 name — The name of the resource in Hyperic. 

 AVAIL — Current availability of the resource 

 ALERTS — Current number of unfixed alerts 

 LOW — Low value during current display range. 

 AVG — Average value during current display range. 

 PEAK — High value during current display range. 

Performance Tab for an Application 

To display the Performance tab for an Insight Application, click the application’s name in the 

Dashboards tab. 

The Performance tab has four sections: 

 Applications 

o The application name is a link — if you click it, Insight Operations will open in a new 

window, and display more detailed resource health and performance metrics for the 

current display range. 

o The Vitals health bar to the right of the application name indicates the current Vitals 

for the application. For a definition of the Vitals metric, see Application Vitals. 

o The Health Trend chart plots the application's "Health" and "Error Rate" metrics for 

the display range. For a definition of the health metric metric, see Application 

Health. 
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o The Invocations chart plots the distribution of request response times across the 

three response time levels defined in Response Time Levels. 

 Application Server 

o This section is expanded if one or more application servers to which the app is 

deployed is unhealthy. Otherwise, the section is collapsed. 

o For information about the metrics presented, see Application Server Performance. 

 Data Service 

o This section is present if the application access a Hyperic managed database 

server.   see Data Service Performance. 

o This section is expanded if the database that the app uses is unhealthy application. 

Otherwise, the section is collapsed. 

o For information about the metrics presented, see Data Service Performance. 

 Platform 

o  This section is expanded if one or more platforms where the app runs is unhealthy. 

Otherwise, the section is collapsed. 

o For information about the metrics presented, see Platform Performance. 

Data Service Performance 

The "Data Service" section is present if the currently selected application accesses a database 

managed by Hyperic. 

The Metric Low/Avg/Peak pulldown lists all of the available platform metrics and shows the 

low, average, and peak values for the metric over the current time range. Choose a metric from 

the list to graph it. 

Below the chart, the following information is listed for each platform: 

 name — The name of the resource in Hyperic. 

 AVAIL — Current availability of the resource 

 ALERTS — Current number of unfixed alerts 

 LOW — Low value during current display range. 

 AVG — Average value during current display range. 

 PEAK — High value during current display range. 

Jump to Insight Operations 

You can jump from the Spring Insight Applications page into the Insight application to 

investigate problems. Click the application name link on the application's Performance tab. 

(See the screenshot in Performance Tab for an Application.)  Insight will open in a new window, 

with the application selected in the Browse Resources tab, where you can view more detailed 

application health data for display range currently selected in the Hyperic user interface. 
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Run Live System and Metric Queries 

 JMX MBean Query for JVMs 

 Run Live Exec Queries 

JMX MBean Query for JVMs 

The JMX MBean Query tool allows you to search for MBeans, display their attributes, and 

invoke selected MBean operations on them. 

When HQ alerts you of availability or health issues with a JVM resource or service, you can use 

the JMX MBean Query tool to troubleshoot and resolve the problem. 

The MBean attributes displayed in the JMX MBean Query tool are read-only; the console does 

not support attribute editing.  In this version of HQ, support for MBean operations is limited to 

operations with one or no arguments of primitive or simple type. 

The JMX MBean Query tool is available on the Views tab when you have a JVM selected in the 

HQ portal. These instructions assume that your JVM is in HQ inventory. 

Note that JVMs are not auto-discovered by HQ. You must add a JVM to HQ inventory and 

configure for monitoring as described in Sun JVM. 

Entering Query Options 

To access specific MBean attributes and operations, you enter search patterns in the these text 

boxes in the JMX MBean Query tool page: 

 Object Name Pattern - To specify the MBean or Mbeans of interest, enter a  valid 

MBean object name pattern. 

 Attribute Regex Filter - To restrict the attributes returned, enter a valid Java regular 

expression. 

 Operation Regex Filter - To restrict the MBean operations returned, enter a valid Java 

regular expression. 

Click the Query MBeans button to execute the search.  

For MBeans whose object name matches the Object Name Pattern, attributes and operations 

that match your filter criteria will be listed. 

Enabling Automatic Refresh 

If you wish the console to periodically refresh the attribute values, select an interval from the 

Refresh Interval pulldown.  
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Defining Saved Mbean Searches 

If you expect to perform the same search frequently, you can create an XML file that specifies 

the search criteria. You name the file according to a predefined convention, and store it in a 

specific directory in your HQ Server installation. Each saved search will appear in the MBean 

Query page's Preset Searches menu. 

When you run a saved search, the values you defined for the search Object Name Pattern, 

Attribute Regex Filter, and Operation Regex Filter appear in the text boxes at the top of the 

view. 

Create a saved search in accordance with the schema described below in [Schema for JMX 

Search Criteria}, and save it with a name like this: 

Name the file that contains a saved search like this: 

SearchID-filter.xml 

where SearchID is a meaningful name for the search to which you append "-filter.xml" identifies 

the search 

The filters values defined in this file will then appear in the Preset Searches drop-down menu 

and will be named according to the filter ID. Save the file in:  

ServerHome/hq-engine/hq-server/webapps/ROOT/hqu/jmx/conf 

The following topics defines the XML schema for saved MBean searches. 

Schema for JMX Search Criteria 

A saved MBean search criteria consists of: 

 A top-level filters element, containing at least one filter sub-element. Each filter sub-

element consists of: 

o An id attribute containing an identifier for the search. This string will appear in the 

Preset Searches drop-down menu. Each search you define and save on an HQ 

server must have a unique d attribute. 

o An objectName sub-element, whose value is the object name pattern used for the 

MBean query.  

o An attributeRegex sublement, whose value is the Java regular expression used to 

filter the attributes returned from the MBean query.  

o An operationRegex sublement, whose value is the Java regular expression used to 

filter the operations returned from the MBean query. 
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For example: 

<?xml version="1.0" encoding="UTF-8"?> 

 

<filters> 

 

  <filter id="JVM Memory MBean"> 

    <objectName>java.lang:type=Memory</objectName> 

    <attributeRegex>.*Usage</attributeRegex> 

    <operationRegex>.*</operationRegex> 

  </filter> 

 

  <filter id="JVM Platform MBeans"> 

    <objectName>java.lang:*</objectName> 

    <attributeRegex>.*</attributeRegex> 

    <operationRegex>.*</operationRegex> 

  </filter> 

 

</filters> 

 

Run Live Exec Queries 

Hyperic's Live Exec view allows you to run system commands on a managed platform, or a 

group of platforms. 

Live Exec uses Hyperic's SIGAR — an API for gathering system information in real-time. The 

table below describes the queries you can run from Live Exec. 

Command Data Returned 

cpuinfo All CPUs on a platform.  

cpuperc Usage percentages on each CPU and related data. 

Equivalent to uptime command.  

df All filesystems on a platform. This does not list disk-usage 

percentages. 

ifconfig Network statistics on each of the platform's network 

interfaces  

netstat Active socket connections on the platform  

top All processes (that the Hyperic Agent can see) running on 

the platform.  

If a process is not listed, it is most likely because the 

Agent does not have permission to see it. 

 

who Logged-in users  



84 

Run Live Exec on a Platform or Group of Platforms 

To run Live Exec: 

1. Navigate to a platform, or a group of platforms in the Resource Hub. 

2. Click the resource's Views tab. 

3. On the  Views tab, click Live Exec. 

The Live Exec page appears. Available queries are listed in the left page. 

If the selected resource is a group, the individual platforms in the group appear as well. 

You can select individual platforms within the group. 

4. Select a command from the Please select a query to run pulldown. 

Command results appear in the right side of the page. 

o If the resource is an individual platform, the results pane includes its name, with the 

name of the platform  and the selected command listed about the data table.  

o In the case of a group: 

 If a member of the group has not previously been selected, click  next to a 

specific platform now. That platform will be displayed first by default for 

subsequent commands. 

 If a member of a group is not available,  is displayed next to the resource, 

and, when it is clicked, the reason why it is unavailable is displayed at the 

right. 

 To view the real-time data for another platform in the group, click  next to 

that platform.  The platform for which data is currently being displayed is 

highlighted at the left. 

If the Hyperic  Agent cannot reach the platform, an error message is displayed. 



85 

Use Resource Control Actions 

 Run Resource Control Actions 

 View Control Action Status and History 

Run Resource Control Actions 

This section has instructions for running control actions on resources that support control 

actions. There are two types of control actions in Hyperic: control actions enabled by the 

managing resource plugin, and custom control actions implemented by Hyperic administrators. 

For more information, see Resource Control in Hyperic. 

The process you use to selecting a control action to run varies for built-in and custom control 

actions: 

 You select built-in control actions from the Control tab of the target resource — 

generally a server type. 

 A custom control action is configured by a Hyperic administrator as service (of type 

"FileServer Service") on the platform where it runs. So, even if a custom control action 

target a server running on the platform, to invoke it, you navigate the platform service 

that represents the service on the parent platform. 

Run a Built-in Control Action 

To run a built-in control action — one that is enabled by a resource plugin — you navigate to the 

target resource, usually some type of server. (Control actions are typically available for servers, 

not for platforms, and rarely for services.) 

1. Navigate to the target resource. 

2. Click the Control tab. 

The Control page appears. 

3. In the Quick Control section of the page, use the Control Action pull-down to display a 

list of supported actions. 

4. Select the desired control action, and click the green arrow to the right to initiate it. 

Select and Run a Custom Control Action 

Follow the instructions in Select from a List of All Custom Control Actions or Select from a List 

Custom Control Actions for a Platform, and then run the action, as described in Run Custom 

Control Action. 

Select from a List of All Custom Control Actions 

To select from a list of all custom control actions: 

1. Use Browse > Services > FileServer File. 

The Services > FileServer File page lists all custom control actions defined in your 

Hyperic deployment. 
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2. Click the name of the custom action you want to run. 

The Monitor tab for the custom control action appears. 

3. Click the Control tab , and follow the instructions in Run Custom Control Action. 

Select from a List Custom Control Actions for a Platform 

To select from a list of control actions for the resources on a platform. 

1. Navigate to the platform. 

Custom control actions for a resources are listed in the "Platform Services Health* 

section. 

2. Click the desired control action. 

The Monitor tab for the custom control action appears. 

3. Click the Control tab, and follow the instructions in Run Custom Control Action. 

Run Custom Control Action 

1. Navigate to the desired a custom control action using one of the options described in the 

previous procedures. 

2. In the Quick Control section of the page, select "Run" from the  Control Action pull-

down to run the control action. 

Schedule a Control Action 

You can schedule a control action to be run in the future — either once, or on a recurring basis. 

1. Select the Control tab: 

o To schedule control actions for a resource with built-in control commands, navigate 

to the target resource, as described in Run a Built-in Control Action 

o To schedule custom control actions, navigate to the platform service that 

represents, it following the in Run a Built-in Control Action, Select from a List of All 

Custom Control Actions or Select from a List Custom Control Actions for a Platform. 

2. In the Control Action Schedule section of the page, click New. 

3. On the New Scheduled Control Action Page select a control action from the Control 

Action ;pulldown. 

a. Description — Type a description, if desired. 

b. Start — Specify when you want to run the control action (or kick off a schedule of 

periodic control action execution): 

 Click  immediately if you want Hyperic to initiate the control action as soon 

as you save the schedule. 

 Otherwise, select the date and a time you want Hyperic to run the control 

action. 
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The Recur pulldown appears.  

c. Select how frequently Hyperic should repeat the control action. 

 Never - Choose this if you only want to run the command once. 

 Daily  

 Weekly  

 Monthly  

d. Click OK. 

View Control Action Status and History 

This section has information about how to view control action history.  

The Control Actions portlet displays information about recent control actions performed on 

resources over a configurable period of recent history.  

 Recent Control Actions - This section lists the individual resource control action 

performed during the configured period, starting with the most recent.  The following 

information is displayed for each resource: 

o Resource Name — Name of the resource. 

o Control Action — The control action that was performed. 

o Date/Time — When the action was performed 

o Message — Results of the control action. 

 Quick Control Frequency - This section lists the resources upon which the most on-

demand control actions have been performed during the configured interval. The 

following information is displayed for each resource: 

o Resource Name — Name of the resource. 

o # of Control Actions — How many control actions were performed during the 

interval. 

o Most Frequent Control Action - The control action that was most frequently 

performed. 

Configure the Control Actions Portlet 

To configure the amount of data in the Control Actions portlet: 

1. Click the gear icon in the upper right corner of the Control Actions portlet. 

The HQ Dashboard Settings: Control Actions page appears. 

2. Configure what appears in the Recent Control Actions section using the first row of 

filters. 

a. Check the box next Control Action Range if you want to list recent control actions in 

the portlet.  (To stop the display of this data, uncheck it.)  

b. In the first drop-down list, select the maximum number of completed control actions 

to list. 

c. In the second drop-down list, select the time range from which to gather that data.  
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3. Configure what appears in the *Quick Control Frequency *section using the second row 

of filters:  

a. Check the box if you want to list the resources with the most on-demand control 

actions.  (To stop the display of on-demand control-action data, uncheck it.) 

b. Select the maximum number of resources to list. 

4. Click OK. 

View Control History for a Resource 

To view a list of control actions that were performed on a resource: 

1. Navigate to the resource in the Resource Hub. 

2. Click the Control tab, which is present only if Hyperic supports control action for the 

selected resource type. 

3. Click History on the  Control tab. 

The Control History page appears. 

The Control History page lists the following information for actions that were performed 

on the resources: 

o Control Action — The action performed. 

o Arguments — Arguments supplied to the control action. 

o Command State — Status of the action:  "Completed", "In Progress", or "Failed".  

o Date Started — Date and time that the control action was initiated. 

o Elapsed Time — How long it took to perform the control action. 

o User — User name of the Hyperic user who initiated or scheduled the control action 

o Message — (optional) Additional information about the control action. 

To delete a control action, place a checkmark next to it in the list, and click Delete at the bottom 

of the page. 
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View Alerts and Update Alert Status 

This section describes options for displaying the status of fired alerts, marking an alert "fixed", 

and acknowledging an alert that has an escalation. 

 List Recent Alerts 

 List Alerts for a Resource 

 View Alerts Across All Resources 

 Monitor Unfixed Alerts 

 View Alert Detail 

 Acknowledge or Fix an Alert 

List Recent Alerts 

The Dashboard's Recent Alerts portlet displays alerts that have recently been fired. You can 

limit the alerts shown by affected resource, priority, and quantity.  

List Alerts for a Resource 

The Alerts List page for a resource lists presents key information and status about alerts that 

have fired for the resource. By default, alerts that have fired on the current day are listed. You 

can select a different day to view. 

1. Browse to the resource. 

2. Select the Alert tab. 

View Alerts Across All Resources 

vFabric Hyperic's Alert Center, available on the Analyze tab in the Masthead, provides system-

wide and filtered views of fixed and unfixed alerts. You can include all alerts or those fired 

during a specified period, and filter by: 

 whether the alert applies to an individual resource or a resource group 

 minimum priority 

 whether the alert is "not fixed" or "in escalation" 
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Monitor Unfixed Alerts 

The Operations Center page, available on the Analyze tab in the Masthead, provides system-

wide and filtered views of unfixed alerts. You can filter by platform or group, and whether or not 

the alerts have escalations. 

View Alert Detail 

There are several pages from which you can access the Alert Detail page for a fired alert: 

 Click the alert name on the Alert List page. 

 Click the alert definition name on the "Alert Center" page.* 

 Click the date/time for an alert in the Recent Alerts portlet on the Dashboard. 

Acknowledge or Fix an Alert 

There are several pages from which you can mark an alert "Fixed", or acknowledge an alert that 

has an escalation: 

 Recent Alerts portlet on the Dashboard  

 Alert List page 

 Alert Detail page 

 Alert Center page 


